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1.  Introducing ActiveXperts Network Monitor 

1.1.  Product Overview 

ActiveXperts Network Monitor is a network and server monitoring tool to allow administrators to 
monitor the network for failures and irregularities automatically. It can monitor all aspects of 
your LAN- and WAN servers, workstations and IP devices. 
For years, System Administrators, Network Operators and Helpdesk Employees have relied 
upon the power, flexibility and reliability of the ActiveXperts Network Monitor tool. 
 
The mission of the product is to maximize the reliability of your production servers and 
applications through the automatic detection and correction of problems and issues. 
The product runs as a service on a Windows 2008/Vista/2003/2000/XP platform, 32-bit or 64-
bit. 
 
When problems are detected, you're immediately notified by e-mail, SMS, pager, SNMP trap or 
network message. When a failure is detected, the network monitor tool will try to correct the 
problem. ActiveXperts Network Monitor consists of a Network Monitor Engine (a Windows 
service) and a Network Monitor Manager application. 
 
The Network Monitor Engine is the service that continuously monitors the servers, 
workstations and IP devices in your LAN/WAN for availability. The service is also responsible 
for notifying, triggering actions, recovery and logging. Thereôs no agent software required on 
the servers being monitored; the monitoring service uses protocols and application layers of the 
Operating System to do its job. 
 
The Network Monitor Manager application is used to view the results and to make changes 
to the configuration. This Manager application allows you to visually monitor the network from 
any desktop PC. 
 
The Manager application can be installed on any Windows 2000 or higher computer 
(workstation or server), and has different authority levels. You can for instance restrict your help 
desk staff to only see monitoring results, and allowing network operators to make changes to 
the configuration. 

1.2.  Product Features 

Ƹ  Monitoring features 

È Monitoring various operating systems, including Windows, Linux, Unix and Novell; 
È Monitoring various application services; 
È Monitoring various databases, including Oracle, MS SQL, MS Access, OLE DB (ADO) 

compliant and ODBC compliant databases; 
È Monitoring environmental data, including temperature, humidity and wetness; 
È Monitoring networks, network protocols and network services; 
È Ability to write custom monitoring checks VBScript (Windows) or SSH (Linux); 
È Checks are processed simultaneously by the multi-threaded monitoring engine. By 

default, there are 30 threads to process monitoring checks simultaneously; 
È The engine is self-tuning; the number of threads adapt to the number of checks to be 

processed per minute; 
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È Software is provided with powerful, pre-defined monitoring checks. 

Ƹ  Notification features 

È Send out notifications upon failure and/or upon recovery; 
È Native support for SMTP e-mail notifications; Outlook or IIS/CDONT are not required; 

Multiple character sets are supported, including English, Arabic, Chinese and Japanese; 
Support for a fallback SMTP server in case the primary SMTP server is not working; 

È Pager Notifications; numeric Pager support through a modem connected to the local 
COM port; alpha-numeric Pager support by the use of SNPP providers; 

È SMS Notifications; requires either a GSM modem, a subscription with an HTTP compliant 
SMS provider, or a subscription with an SMPP compliant SMS provider (the latter 
requires ActiveXperts SMS Messaging Server running on a server in the  network); 

È SNMP Trap Notifications; send trap notifications to an SNMP Management console; 
supports SNMP v1 traps and SNMP v2 or higher SNMP traps; 

È NetBIOS Network Notifications (also known as "network popup" messages); 
È Global and Custom Address Lists; for all notification types (E-mail, SMS, Network and 

Pager) a custom list can be defined, or the global Address Book can be selected; 
È Templates for all notification types, including network monitor system parameter inside 

these templates. Notification messages can be completely customized using these 
templates. 

Ƹ  Action features 

È Restart a service (or multiple services) upon failure; 
È Reboot a server upon failure; 
È Launch an executable or batch command job; use Network Monitor system parameters 

as arguments for the executable or batch-job; 
È Launch a VBScript; Use Network Monitor system parameters as arguments for the script. 

Ƹ  Configuration 

È Configuration information is stored in an MS Access database; 
È Support for Import and Export of the configuration; Import and Export are guided by a 

Wizard; 
È Default values for new monitoring checks are configurable, and can be applied to existing 

monitoring checks; 
È Read-only mode for users that are not allowed to make changes to the configuration (for 

instance: help desk employees); 

Ƹ  Maintenance schedules 

È Avoid servers to be considered as Failed during maintenance hours. Notifications and 
actions will not occur during these schedules; 

È Maintenance periods can be configured globally or per check; 
È Maintenance periods can be scheduled as recurrent or only once; 
È Multiple maintenance schedules can be defined. 

Ƹ  Dependencies 

È Avoid a flood of messages when - for instance - a router fails, by configuring 
dependencies; 

È Servers can depend on multiple servers; dependencies are transitive. 
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Ƹ  Reports 

È Standard incident reports and availability reports are included; 
È The óReport Configuratorô guides the user to quickly setup new report definitions. Report 

Definition files can be used to either create a new report from the command line 
(scheduled, without user intervention) or from the graphical Report Generator; 

È Reports can be scheduled using the Task Scheduler; 
È Reports can be e-mailed automatically, periodically; 
È Support for XML, HTML and CSV ('comma separated') formatted reports; 
È Particular checks, folders and results can be included/excluded from a report; 

Ƹ  Logging 

È Network Monitor related information is written to the Application Log of the Event Viewer; 
È Monitoring information is written to ASCII log files or any OLE DB compliant database, 

including MS Access and MS SQL; 
È Maximum ASCII Log file size is configurable; a new log file is created when a maximum 

size is reached; 
È Report Data is written to an MS Access database by default. A migration wizard assists 

the user to migrate report data to MS SQL. 

Ƹ  User Interface 

È Use the Manager application to make changes to the configuration and view the 
monitoring results; 

È The Manager application can be installed on any workstation in the network, allowing 
operators to monitor and configure Network Monitor from their desktop; 

È The Manager application has an Explorer-like user interface, with a Folder pane, a 
Monitoring Checks pane and a Log pane; 

È Assign Read-only permission to the people who do not need full access to the 
configuration. In Read-only mode, users can only view the results, but are not able to 
change the configuration. 

È The Web Interface allows users to view the status of the network by using the Internet 
Browser. The Web Interface consists of a set of web pages, also called Web Views. Web 
Views are based on XML/XSL technology. The views are created dynamically by the 
Network Monitor service, and can be customized easily by modifying the corresponding 
XSL templates. 

1.3.  Built-in Monitoring Checks 

ActiveXperts Network Monitor ships with powerful set of monitoring checks. 
 
IP-related checks: 
È DNS Server check ï checks various types of DNS server records by retrieving record 

values and comparing them against specified values; 
È FTP check ï checks the availability of an FTP server. It can logon/logoff, change directory 

and check for file existence on the FTP server. It can look for patterns in an FTP file; 
È TFTP check ï checks for file existence on the TFTP server. It can look for patterns in a 

TFTP file; 
È HTTP/HTTPs check ï checks the availability of a website by connecting to it and 

matching patterns on the site; includes support for proxy servers; 
È ICMP/Ping check ï checks the availability of an IP device or computer; 
È IMAP Mail Server check ï checks the availability of an IMAP compliant e-mail server; 
È LDAP check ï performs an LDAP query and analyzes the result; 
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È NNTP News Server check ï checks the availability of an NNTP News server, using the 
NNTP internet protocol; 

È NTP Time Server check ï checks the availability of a Time Server by sending an NTP 
query and analyzing the response; 

È POP3 Mail Server check ï checks the availability of a PO3 e-mail server; 
È RADIUS Server check ï checks the availability of a RADIUS authentication server; 
È SMTP Mail Server check ï checks the availability of an SMTP mail server; 
È SMTP to POP3 check ï checks if e-mail service is working properly by sending a test e-

mail through an SMTP server and verifying that it has been delivered to the recipient's 
mailbox; 

È SNMP GET check ï queries a computer or device using the SNMP (ñSimple Network 
Management Protocolò) protocol, and analyzes the result; 

È SNMP Trap Receive check ï receives SNMP traps from various machines/devices, and 
analyzes the message; 

È TCP/IP check ï checks if a connection can be established on a particular TCP port; 
 
Windows-related checks: 
È Anti-Virus/Anti-Spam check ï checks status and version of anti-virus software on a 

workstation or server; 
È CPU usage check ï monitors CPU usage of processor(s) on a Windows platform. If the 

load reaches a certain level (for instance: 80%), an alert is generated; 
È Directory check ï monitors a directory, for instance a userôs Home Directory or a common 

Department Folder; 
È Disk Drive check ï monitors a physical disk drive on a workstation or server running a 

Windows Operating System; 
È Disk Space check ï checks the disk space; an alert is fired when a minimum (or 

maximum) is exceeded; 
È Event Log check ï checks for certain events in the Windows Event Log; 
È File check ï checks if a file exists on a server. It can also check the size of the file and 

look for specific patterns in the file; 
È Memory check ï monitors various memory counters of a Windows computer; 
È Microsoft Exchange check ï monitors the status of an MS Exchange Server 

(2007/2003/2000/5.x); also monitors the most important MS Exchange performance 
counters;  

È Microsoft ISA Server check ï monitors the status of the caching component and/or 
firewall component of an ISA Server (2006/2004/2000); 

È Microsoft Message Queue (MSMQ) check ï monitors a Microsoft Message Queue; 
È Microsoft SharePoint Server check ï monitors the status of an MS SharePoint Server 

(2007/2003); also monitors the most important MS SharePoint performance counters;  
È Printer check ï checks a printer for availability by checking status information; 
È Process check ï checks a process to see if it is running. It can check the memory usage 

of a process, and count the number of identical processes running. It can also check for 
any process consuming too much memory; 

È Scheduled Task check - checks if a scheduled task has completed successfully or not; 
È Service check ï  checks if a service is running on a server; 
È User/groups check ï checks groups and group membership; 
È VBScript custom check ïdefine your own custom VBScript checks. It should return True 

for success or False for an error. You can include WMI (Windows Management Interface) 
and ADSI to add a broad range of system checks. 

 
Environmental checks: 
È Door check ï environmental check to monitor a door; this requires a Sensatronics 

Senturion device; 
È Humidity check ï environmental check to monitor humidity; this requires a Sensatronics 

environmental monitoring device (e.g. Sensatronics EM1, Sensatronics Senturion); 
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È Power check ï environmental check to monitor power. Requires a Sensatronics 
Senturion device; 

È Resistance check ï environmental check to monitor resistance; this requires a 
Sensatronics Senturion device; 

È Switch (NC) check ï environmental check to monitor a switch (NC); this requires a 
Sensatronics Senturion device; 

È Switch (NO) check ï environmental check to monitor a switch (NO); this requires a 
Sensatronics Senturion device; 

È Temperature check ï environmental check to monitor temperature. This requires a 
Sensatronics environmental monitoring device (e.g. Sensatronics EM1, Sensatronics 
Senturion); 

È Wetness check ï environmental check to detect water leaks. This requires a 
Sensatronics environmental monitoring device (e.g. Sensatronics EM1, Sensatronics 
Senturion). 

 
Database checks: 
È Database Query check ï ActiveXperts Network Monitor uses OLE DB (also known as 

ADO) to check availability of any OLE DB complaint database, including Microsoft SQL, 
MS Access, Oracle, Paradox and more. You can enter a database query and check the 
result of the query to determine the result of the check;  

È ODBC Database check ï checks the availability of a database. Most major database 
systems support ODBC; 

È Oracle Database check ï checks for availability of Oracle database by through the 
SQLNET interface; 

 
Linux/Unix checks: 
È RSH check ï checks a Linux/ Unix server by executing remote shell scripts (unsecure) 

and processing StdErr and/or StdOut; 
È SSH check ï checks a Linux/ Unix server by executing remote shell scripts (secure) and 

processing StdErr and/or StdOut; 
 
Miscellaneous checks: 
È Serial Device check ï checks a device connected via a serial COM port. 

 
Add new functionality to the product by writing your own VBScript routines. This way, you can 
monitor almost every piece of hardware, network protocol, software, and so on. Also, VBScript 
allows you to include techniques like WMI (Windows Management Interface) and ADSI (Active 
Directory Service Interfaces). 

1.4.  Custom Monitoring Checks 

ActiveXperts Network Monitor allows you to extend the set of built-in check routines by writing 
your own check routines. 
ActiveXperts uses VBScript for custom checks, because of its wide acceptance and its support 
for ActiveX technologies. ActiveXperts Network Monitor can process up to 16 VBScript scripts 
simultaneously (multi-threaded).  
The Network Monitor engine uses the Visual Basic Scripting Engine that is part of the Windows 
Operating System.  
By using ActiveX controls, WMI and ADSI, you can write virtually any check yourself. Use the 
following guidelines when writing a new check: 
È The routine must be a Function, not a Sub; 
È The Function must return True (-1), False (0) or Unknown (1); 
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È Set the SYSDATA system variable to the value used in the check. For instance, in a CPU 
check you can assign the actual CPU value to SYSDATA, so it will be displayed by the 
Manager application, and is also written to the Log file and report database; 

È Set the SYSEXPLANATION system variable to specify a detailed result; this result is 
displayed by the Manager application, and is also written to the Log file and report 
database; 

È All variables must be 'dimmed'. 
 
To monitor Linux and Unix computers, you can make use of custom shell scripts. The shell 
scripts must be located on the Linux/Unix machine, and should output the result of a check 
using the following output format: 
   [ SUCCESS | ERROR | UNCERTAIN]: { <explanation> } { DATA:<value>}  

 
For example: 

Success: Disk space is more than 30 GB  Data:45  

This indicates that the check failed 
 
Another example: 

Uncertain: Unable to determine disk space  

This indicates that the check was successful. ó45ô indicates the current disk space, and is 
displayed in the óDataô column in the Manager application. 

1.5.  Notifications 

There are two situations in which notifications are sent to the system administrators: 
È In case of a Failure; 
È In case of a Recovery. 

 
You can configure the following types of notifications: 
È E-mail notification ï Send e-mail messages to the system administrators. A SMTP 

compliant mail server is required on the LAN/WAN network. SMTP authentication is 
supported. A secondary mail server is supported, in case the primary mail server is not 
available; 

È SMS messages ï Send alpha-numeric SMS messages, either via a GSM modem 
connected to the server (Bluetooth/Serial/Infrared) or via an SMPP provider (requires 
ActiveXperts SMS Messaging Server); 

È SNMP Trap notifications ï Send SNMP v1 and SNMP v2c trap notifications to a (remote) 
network manager. It supports different data types, including strings, integers, IP 
addresses, time ticks and OIDôs (object identifiers); 

È Pager messages ï Send numeric Pager messages to (mobile) phones or numeric pagers 
using a Hayes compatible modem. Send alpha-numeric Pager messages using an SNPP 
provider; 

È Network notifications ï Send Network Popup notifications, based on NetBIOS 
user/computer names; 

 
For each notification type, thereôs an Address Book. The Address Book organizes recipients in 
groups; these groups can be used in all monitoring checks, so you donôt need to define a 
recipient list for each check.  
 
For each notification type (except SNMP Trap) you can define Message Template. A Message 
Template defines the body of a notification message (E-mail, SMS, NetBIOS). The message 
template contains plain text, and includes variables like: TDATET, TTIMET, TDISPLAYNAMET, TRESULTT 
and more (See also Appendix C: ñNotification Variablesò). These variables are substituted by 
the Network Monitor Engine at runtime (i.e. when the message is sent out).  
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Notifications can be repetitive. This means that you can configure a notification to be sent out 
every Tx T minutes after a server/device went down. 

1.6.  Actions 

Actions work in the same way as notifications: they can be triggered upon a critical condition 
(Failure) or upon Recovery. You can configure the following actions: 
È Execution of a Windows program (executable, batch job or VBScript program); 
È Restart of a Windows service (or multiple services); 
È Reboot of a Windows server or workstation. 

 
Actions can be repetitive, i.e. you can trigger an action every x minutes after a server/device 
went down. You can pass credentials (login and password) for the Restart and Reboot actions; 
this makes sense if the service account, used for the ActiveXperts Network Monitor service ï 
has no administrative rights on the remote computer. 
 
For batch programs, executables and VBScript programs, you can use parameters like: TDATET, 
TTIMET, TDISPLAYNAMET, TRESULTT and more (See also Appendix C: ñNotification Variablesò). 
These variables are substituted by the Network Monitor Engine at runtime. 

1.7.  Errors, Failures and Recovery 

A Monitoring Check is always in one of the following states: 
È OK; 
È Error; 
È Failure; 
È Maintenance; 
È Failure by Dependee; 
È On Hold; 
È Not Monitored; 
È Uncertain. 

 
Thereôs a difference between an error, a failure, a failure during maintenance and a failure by 
dependency: 

Ƹ  óOKô State 

The check meets all the conditions. The corresponding computer/device is working fine.  

Ƹ  óErrorô State 

If a check doesnôt match the conditions as defined by the system operator for a while, itôs 
considered as an Error. Think of an ICMP check for server ówww.activexperts.comô. 
Sometimes, the ping will fail (for instance once a week), because a router on the internet has a 
hick-up. You donôt want to ring all bells and whistles in this situation. So, the check is in the 
Error state. But when this error happens a couple a times in a row, itôs considered as a Failure. 
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Ƹ  óFailureô State 

A Failure is the occurrence of one or more Errors in a row. The number of errors (letôs say x, 
the so called threshold) is configurable. After x errors in a row, it is called a Failure. Only on 
failure, notifications are sent out and actions are triggered. 
For instance, with an óICMP Pingô check that has the threshold set to 5, a failure notification will 
be sent after 5 consecutive error pings. 

Ƹ  óMaintenanceô State 

If the result of a check is not successful during a Maintenance period, it wonôt be considered as 
a regular Error or Failure. Instead, the result will be: Maintenance. This indicates that the 
negative result is caused by maintenance on servers, devices or network. No notifications will 
be sent and no actions will be triggered. 

Ƹ  óFailure by Dependeeô State 

If a check fails as a result of another failed server, and there is a dependency relation between 
these checks, it will not be reported as a regular failure; no notifications will be sent and no 
actions will be taken.  
Imagine you have a server óS1ô on a remote location, and thereôs router óRô connecting your 
LAN with the remote location, and you have ICMP checks for both óS1ô and óRô.  
By making óS1ô dependent of óRô, a failure of óRô will only result in notifications for óRô, not for óSô. 
Dependencies can be configured from the Dependency command in the Tools menu. 

Ƹ  óOn Holdô State 

You can put a check óOn Holdô. This means, that the check will not be monitored as long as the 
check remains óOn Holdô.   

Ƹ  óNot Monitoredô State 

When a check cannot be processed by the engine, the state is set to Not Monitored. Think of 
a monitoring check based on the SNMP check, but the Network Monitor Engine doesnôt have 
the SNMP service installed. It cannot process the check and will set the result to Not 
Monitored. 

Ƹ  óUncertainô State 

When the result of a check cannot be determined by the Engine, the state is set to Uncertain. 
Think of a Disk Space monitoring check, monitoring free disk space on a file server. If the file 
server becomes totally unavailable, the Network Monitor Engine cannot determine the Disk 
Space. In this situation, the result is set to Uncertain. 
 

Note:  You can change the way Network Monitor handles óUncertainô events. By default, all 
checks which results cannot be determined are set to Uncertain. You can configure 
not to use the óUncertainô state, and set each undetermined result to either 
Success or Error. 

Ƹ  About Recovery 

When a server leaves the Failure state and enters the Success state, weôre talking about 
óRecoveryô. óRecoveryô itself is not a state; however, in this situation, Notifications can be sent 
and Actions can be triggered. This can be useful for Administrators and Operators, so they 
know that an Action was successful. 
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1.8.  Maintenance Schedules 

In most companies, system maintenance is done on specific time intervals. 
During maintenance, some servers or services will not be available to users. For instance, 
during backup hours, some services/daemons will be down to avoid open files, mail servers will 
be stopped, and so on. 
 
In these situations, the Network Monitor Engine will not send alerts or trigger actions in case of 
a failed check. To accomplish this, you can define Maintenance Schedules. During these 
periods, no actions/notifications will be triggered in case of a failure. 
 
Maintenance Schedules can be configured globally (for all monitoring checks) or at the 
Monitoring Check level. You can define multiple maintenance schedules. 



  Chapter 2.  Installing ActiveXperts Network Monitor 

   

      ActiveXperts Network Monitor      10 

2.  Installing ActiveXperts Network Monitor 

2.1.  Software components 

The central monitoring service runs on a (dedicated) Windows 2008/Vista/2003/XP/2000 
computer; it monitors computers/devices in your LAN, WAN or even outside your enterprise. No 
additional software is required on the monitored servers. 
The graphical Manager application is running on the operators desktop PC; it connects to the 
central monitoring service, and allows you to make changes to the configurations, and view the 
results. 

Ƹ  Network Monitor Engine 

The ActiveXperts Network Monitor Engine is a Windows Service (TAXSNMSVC.EXET), and is the 
actual monitoring program. It polls the computers/devices in your LAN/WAN for availability at 
specific time intervals. This service is multithreading, allowing the service to monitor many 
computers/devices simultaneously.  
The service is responsible for notification, actions, recovery, logging, and so on. 
 

Note:  ActiveXperts Network Monitor doesnôt require agent software on the servers you 
monitor; the service only uses protocols and application layers of the Operating System 
to do its job. 

 

Ƹ  Network Monitor Manager 

The ActiveXperts Network Monitor Manager application (TAXSNMAPP.EXET) is used to view the 
status of your network and to make changes to the configuration.  
You can install the Manager application on any workstation/server in your LAN/WAN. 
The Manager application makes a connection to the central ActiveXperts Network Monitor Service, 
to write configuration information, and to read monitoring information.  
 
The Manager application can be installed on any Windows 2000 or higher computer (workstation 
or server). 
 

Ƹ  Report Generator 

The ActiveXperts Network Monitor Report Generator can be used to create new reports. There are 
two versions: a graphical version (AXRGGUI.EXE) to create reports using a wizard, and a 
command line version (AXRGCMD.EXE) to create reports from the command line or from the Task 
Scheduler. 
 
Reports can only be created by using a Report Definition file (. rep ). Such a definition file 
describes the properties of a report (like: filters, sorting, layout, output file, etc.). 
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Ƹ  Report Configurator 

The ActiveXperts Network Monitor Report Configurator (AXRGTPL.EXE) can be used to define new 
report definition files. A report definition file (.rep ) can be used as an input file to the Report 
Generator. 
 

Ƹ  Web Interface 

Collection of XML- and XSL files. An XML file can be opened by the Internet browser. The 
associated XSL file is used to make-up the XML page so it can be viewed by your Internet 
Browser. 
 

Ƹ  Web Interface Configurator 

The ActiveXperts Network Monitor Web Interface Configurator (AXWEBCFG.EXE) can be used to 
customize the Web Interface. 
 

Ƹ  Installation Files 

The full ActiveXperts Network Monitor package is available on the internet as a one setup file: 
TAMONITOR.EXE.T 

 
After you download the file from the internet, you start the setup procedure on the server that you 
assigned as the monitoring server. This server doesnôt have to be a dedicated server.  
The installation will install the monitoring service, the Manager application and several tools and 
utilities. 

2.2.  Installing ActiveXperts Network Monitor 

Ƹ  Hardware requirements 

The ActiveXperts Network Monitor service only runs on a Windows workstation or server platform, 
and must meet either of the following requirements: 
 

  Windows 2008 Windows 2003 Windows 2000 Windows Vista Windows XP Prof. 

CPU 1 GHz (x86) 
 or 1.4 GHz (x64) 

550 MHz (x86) 
 or 733 MHz 
(x64) 

x86 133MHz 
or higher 

1 GHz 32-bit (x86) 
 or 64-bit (x64) 

233 MHz (x86) 
 or 733 MHz (x64) 

Memory 1GB or more 256MB 128 MB 512 MB 128 MB 

Service Pack - SP1 SP4 or higher - SP1 or higher 

Available 
Diskspace 

1GB 1GB 500 MB 1GB 500 MB 

 

 
Itôs recommended to use a server platform for the ActiveXperts Network Monitor Service, because 
server platforms support more simultaneous network connections Server platforms are optimized 
for application services. 
 
Usually, the installation is done only once, on the server that is dedicated as the monitoring server. 
A wizard will take you through the installation. 
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Ƹ  Upgrading ActiveXperts Network Monitor from a previous version 

Upgrade of ActiveXperts Network Monitor requires un-installation first, followed by a new 
installation of the software. All configuration files will be preserved during un-installation. However, 
it is recommended to export the configuration to a save place, before you uninstall the product. 

Ƹ  Upgrade ï Step-by-Step 

Step 1 ï Export the Configuration (Recommended, not required) 

In the Manager application, choose Export Configuration from the File menu, and export the 
configuration to a save place. 

Step 2 ï Run the Setup application 

Launch the Setup application (TAMONITOR.EXET). It will detect a previous installation of 
ActiveXperts Network Monitor. It will ask to press OK to uninstall the current installation of 
ActiveXperts Network Monitor. After pressing OK, the software will be uninstalled. The 
previous configuration files will be preserved. 

Step 3 ï Install ActiveXperts Network Monitor 

Launch the Setup application (TAMONITOR.EXET) again. Follow the steps described below. 

Step 4 ï Import a configuration 

After the installation has completed, you can import any Network Monitor configuration file, no 
matter what version of Network Monitor was used to create it. 

 

Ƹ  Installing ActiveXperts Network Monitor 

Before you start the installation, you must assign one of your Windows servers in your network as 
the ActiveXperts Network Monitor Server. This machine will host the Network Monitor Engine 
(service). 
 
Download the installation file TAMONITOR.EXET from the internet 
(Thttp://www.activexperts.com/downloadT) and run this program on the server that you assigned as 
the monitor server.  
The following components will be installed on that server: 
È ActiveXperts Network Monitor Service ï the actual Network Monitor Engine; 
È ActiveXperts Network Monitor Manager application ï to let system administrator make 

changes to the configuration and view/analyze results;  
È ActiveXperts Network Monitor Report Generator and Report Configurator ï allows 

administrators to create/modify report definition files, and to create new reports;  
È ActiveXperts Network Monitor Web Interface Configurator ï allows administrators to 

customize the Web Interface;  
È ActiveXperts Network Monitor Remote Manager Configurator ï allows administrators to 

configure the Manager application for use on remote workstations. 

http://www.activexperts.com/download
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Ƹ  Installation ï Step-by-Step 

Step 1 ï Welcome Message 

This is where the installation begins. 

Step 2 ï Setup Type 

Choose ñNetwork monitor Engine + Management Consoleò if you want to install the Network 
Monitor service. The first installation should always be this type of installation.  
After the first installation, you can run a ñManagement Consoleò installation on network 
workstations to allow users to view the monitoring results of Network Monitor, or to make 
changes to the configuration. 

Step 3 ï Registration information 

Here, you can enter you Registration code. If you want to try the software, enter 
óEVALUATIONô as the registration code. You will be able to use the software for 30 days. If 
you decide to buy after 30 days, you donôt need to re-install; the Manager application allows 
you to enter the registration code and the software will continue working. 

Step 4 ï Choose Destination Folder 

Choose a destination folder. Setup will copy the service, the Manager application, the 
Manager Setup files and other components to this location. Please make sure to have 
approximately 50 megabytes available. 

Step 5 ï Select Program Folder 

Specify a name for the Program folder. 

Step 6 ï Service Account 

The Network Monitor Engine (a Windows service) must run with specific credentials. Itôs 
recommended to provide a Domain Admin or Enterprise Admin account, because it is likely 
that ActiveXperts Network Monitor needs access to servers in the domain with administrative 
rights to do its job. However, itôs not mandatory to provide a Domain/Enterprise Admin 
account; for every monitoring check, alternate credentials can be provided. 

Step 7 ï Reboot (only for Windows 2000) 

If you install the software on a Windows 2000 platform, you may be asked to reboot the 
computer. 
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2.3.  Installing Management Console on a Workstation 

Ƹ  About Installing the Management Console 

Use the ActiveXperts Network Monitor Manager application to: 
È Make changes to the configuration; 
È View the monitoring results; 
È Run reports. 

 
The Manager application is already installed by default on the server where the ActiveXperts 
Network Monitor service runs. So, thereôs no need to run ActiveXperts Network Monitor Manager 
installation on the server. 
 
By default, installing ActiveXperts Network Monitor Manager applications on remote computers is 
prevented for security reasons. To allow the installation of the Manager application on other 
computer, a share must be created. This share will be used by the remote Manager application to 
communicate with the Network Monitor Engine. 
To define the Share: 
È Start the ActiveXperts Network Monitor Manager application on the computer where the 

Network Monitor Engine is running; 
È Choose Manager on Remote Workstations from the Tools menu, and select the Install 

Manager on Remote Workstations tab; 
È A wizard pops up; in this wizard, define a Share name and press the Create Share button. 

 
Once you have created the share, youôre ready to install the Network Monitor Manager on remote 
PCôs.  
 
Simply run the AMONITOR.EXE setup program (same installation as used for the server 
installation) on the workstation, and choose óInstall Management Console on a Desktop PC or 
Notebookô. The Setup program will now prompt for a share. Enter the share (UNC format) of the 
central ActiveXperts Network Monitor directory. 
 
To be able to run the Network Monitor Manager application on workstations, Users (operators) 
need Change (RWX) permissions on the files in the shared directory. 
 

Note:  To allow/prevent users in the network from installing/running the Network Monitor 
Manager, simply use NTFS permissions or Share Permissions. The easiest is to use 
Share Permissions: simply add/remove RWX permissions to allow/prevent Users or 
Groups at Share level. 

Ƹ  Hardware requirements 

The ActiveXperts Network Monitor Manager application runs on Windows 2000 Professional 
platforms or higher, and must meet either of the following requirements: 
 

  Windows 2008 Windows 2003 Windows 2000 Windows Vista Windows XP Prof. 

CPU 1 GHz (x86) 
 or 1.4 GHz (x64) 

550 MHz (x86) 
 or 733 MHz 
(x64) 

x86 133MHz 
or higher 

1 GHz 32-bit (x86) 
 or 64-bit (x64) 

233 MHz (x86) 
 or 733 MHz (x64) 

Memory 1GB or more 256MB 128 MB 512 MB 128 MB 

Service Pack - SP1 SP4 or higher - SP1 or higher 

Available 
Diskspace 

1GB 1GB 500 MB 1GB 500 MB 
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Ƹ  Installation Step-by-Step 

Step 1 ï Welcome Message 

This is where the installation begins. 

Step 2 ï Setup Type 

Choose óInstall Management Console on a Desktop PC or Notebookô. It will install the 
Network Monitor Manager, the Report Generator and some utilities on the workstation PC.  

Step 3 ï Location of the central Network Monitor server 

Youôre prompted for the location of the central Network Monitor Server share. Enter the 
share, as created on the server machine by the óNetwork Monitor Remote Manager 
Configuratorô.  

Step 4 ï Choose Destination Folder 

Choose a destination folder. Setup will copy all client application files to this location. Please 
be sure to have approximately 5MB available, depending on the type of installation. 

Step 5 ï Select Program Folder 

Specify a name for the Program folder. 

Step 6 ï Reboot (only for Windows 2000) 

If you install the software on a Windows 2000 platform, you may be asked to reboot the 
computer. 
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3.  Configuring ActiveXperts Network Monitor 

3.1.  Introduction 

The ActiveXperts Network Monitor configuration consists of two parts 
È Monitoring checks ï all monitoring checks and monitoring properties; 
È Global configuration data ï this data is configured independent from the monitoring checks, 

and contains global notification settings, address books, default settings, web interface 
settings, report settings and more. 

All configuration data is stored in an MS Access database called: CONFIG.MDB. This file is located 
in the <INSTALL - DIR>\ Configuration \  directory. 
 
Use the ActiveXperts Network Monitor Manager application to make configuration changes, to 
view real-time monitoring information, and to analyze results. The Manager application can be 
launched from any Win32 platform, or from the machine where the service is running on. 
 
You donôt need to restart the service every time you make changes to the configuration. The 
service will detect configuration changes as they are made, and will reload the configuration. 
 
The ActiveXperts Network Monitor configuration can be imported, exported and cleared at any 
time. By using the Export command, the configuration can be backed up to a save location. By 
using Import command, a configuration can be loaded and set as the current configuration. By 
using the Clear command, you can clear your current configuration and start from scratch. None of 
the above commands need a restart of the ActiveXperts Network Monitor Service. 

3.2.  ActiveXperts Network Monitor Manager 

To launch the ActiveXperts Network Monitor Manager, click Start, point to the ActiveXperts 
Software folder, point to the Network Monitor folder and click on the Network Monitor 
Manager icon. 

Ƹ  Views 

The ActiveXperts Network Monitor Manager application window is divided into three views: 
È Folder view (left view) ï Checks can be grouped in logical containers called Folders; 
È Checks view (right view) ï list of checks that are organized in the selected folder. The checks 

in the subfolder(s) of the selected folder are also displayed; 
È Activity Log view (bottom view) ï shows the activity of the ActiveXperts Network Monitor 

service. 

Ƹ  Permissions 

The ActiveXperts Network Monitor Manager application can be run in two different modes: 
È Read-write mode (default) ï view results, make reports and make changes to the 

configuration; Read-write access is required for administrators who install and configure 
ActiveXperts Network Monitor. 
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È Read-only mode ï only view results; in Read-only mode, you canôt make changes to the 
configuration. Read-only mode is ideal for people who work at the Help Desk and do first line 
support. 

Ƹ  Assigning permissions 

The next chapter discusses how to assign read-write and read-only permissions to users and 
groups. 

Ƹ  State Information and Icons 

In the server view, an icon precedes every server entry. Hereôs a list of all possible state values 
(with corresponding icons) and their meanings: 
 

 OK ï The check meets all the conditions. The corresponding server/device is working fine. 
 

 Error ï When a check doesnôt meet the conditions as defined by the system operator for a 
while, itôs considered as an Error. For instance, when you configure an ICMP check for web 
server ówww.activexperts.comô, a ping may fail for instance once a day, for example 
because a router on the internet has a hick-up. You donôt want ring all bells and whistles in 
this situation, because the problem has nothing to do with the actual server. So, the check is 
in the Error state. Only when the error happens a couple a times in a row, the status is set to 
Failure. 

 
 Failure ï A Failure is the occurrence of 1 or more errors in a row. This error threshold is 
configurable. Only when the error happens x times in a row, the status is set to Failure. Only 
then, notifications are sent out and actions are taken. 
For instance, when you configure an ICMP check, you should configure to let the check fail 
only after a couple of errors in a row, letôs say 5. So, only when 5 errors occur in a row, the 
result of the check will be: Failure. Only then, Administrators and Operators will be notified of 
this failure event. 

 
 Maintenance ï When the result of a check is not successful during Maintenance hours, it 
wonôt be considered as an ordinary Error or Failure. The result will be: Maintenance, to 
indicate that the negative result is due to the maintenance on computers/devices. No 
notifications will be sent and no actions will be triggered. 

 

 Failure by Dependee ï When a server fails (after a number of errors in a row) as a result of 
another failed server, and there is a dependency relation between them, it wonôt be 
considered as an ordinary failure; no notifications will be sent and no actions will be taken. 
Suppose you have a server óS1ô on a remote location, and thereôs router óRô connecting your 
LAN with the remote location, and you have ICMP checks for both óS1ô and óRô. You should 
make óS1ô dependent of óRô. In that scenario, when óRô fails, you wonôt get 
actions/notifications from óS1ô. 

 
 On Hold ï You can put a check óOn Holdô, so it wonôt be processed by the Network Monitor 
Engine. 

 
 Not Monitored ï Initial state of a check. When the Network Monitor service has just been 

started, all checks will have status Not Monitored. 
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 Uncertain ï When the result of check cannot be determined by the Engine, the state is set to 
Uncertain. Think of a Disk Space check, monitoring free disk space on a File Server. If the 
File Server becomes unavailable (for instance because it has completely crashed), the 
Network Monitor Engine cannot determine the Disk Space. In this situation, the result will be 
set to Uncertain. 

3.3.  ActiveXperts Network Monitor Quick Configuration Wizard 

The first time you start the ActiveXperts Network Monitor Manager application, the Quick 
Configuration Wizard pops up to collect some basic information, like: your SMTP e-mail server, 
your e-mail address, and so on. The Quick Configuration Wizard also adds some sample 
monitoring checks to your configuration. 
 

3.4.  Import, Export and Clear configuration settings 

Ƹ  Import configuration settings 

To import a previously saved configuration, use the Import function. Note that the current 
configuration will be overwritten. 
 

To quickly import a configuration, click Import  on the toolbar.  
To import a configuration: 
È On the File menu, choose Import Configuration; 
È Select the version of the import configuration file, and click Next; 
È In the File name box, enter a name of a previously exported configuration file;  
È Click Finish to finish the import. 
 

Note:  It is possible to Import a configuration file that was created on another computer. 

 

Ƹ  Export configuration settings 

Itôs a good practice to make a backup after major configuration changes. The óExport 
Configurationô function exports all of the configuration settings. This means: all global configuration 
settings (like mail server, default scan time, etc.) as well as all monitoring checks. 
 

To quickly export a configuration, click Export  on the toolbar.  
To export a configuration: 
È On the File menu, choose Export Configuration; 
È In the File name box, enter a name for the new export configuration file; 
È Click Save. 
 

Note:  The Auto Backup feature automatically exports the configuration periodically. Auto 
Backup can be configured from the Auto Backup tab of the Options dialog. 
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Ƹ  New configuration 

The New Configuration function clears the existing configuration and creates a new one. The 
ActiveXperts Network Monitor Manager will ask you to save the current configuration before you 
clear it. 
 

To quickly create a new configuration, click New Configuration  on the toolbar.  
To create a new configuration: 
È On the File menu, click New Configuration; 
È The program will ask if you want to export the current configuration; 
È After the optional export, it asks you if youôre sure to create a new configuration. Press Yes. 

3.5.  Renaming computers 

Ƹ  Renaming the ActiveXperts Network Monitor Engine computer 

To rename the computer where the ActiveXperts Network Monitor Engine is running on, you must 
take the following steps: 
È Export the configuration to a save place, using the Manager application; 
È Stop the Network Monitor Engine; 
È Quit the Network Monitor Manager application. Also quit Network Monitor Manager 

applications on remote workstations (if any); 
È Change the following registry entries:  

HKLM\ Software \ ActiveXperts \ Network Monitor \ Engine0   
HKLM\ Software \ ActiveXperts \ Network Monitor \ Engine0Root  

È Start the Network Monitor Engine; 
È Import the configuration file. The Import Wizard will detect that the configuration was 

previously used on a machine with a different name, and will ask you to confirm so that the 
configuration will be converted. 

È On other PCs in the network that have the Manager application installed, make changes to 
these two registry entries: 
HKLM\ Softwa re \ ActiveXperts \ Network Monitor \ Engine0  
HKLM\ Software \ ActiveXperts \ Network M onitor \ Engine 0Root  

Ƹ  Renaming the ActiveXperts Network Monitor Manager computer 

You can change the name of the computer where the Manager application is running. This will not 
affect the ActiveXperts Network Monitor Manager installation. 

3.6.  Configuring Monitoring Checks 

To add a new monitoring check, click New Monitoring Check   on the toolbar. 
To configure an existing monitoring check, double click on the particular check entry in the 
Manager application, or right-click on the selected check and choose óPropertiesô. 
 
Most important configuration items of a Monitoring Check are: 
È Check What ï the type of check that is performed on a specific network device, server or 

workstation; 
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È Display Name ï the name of the check to be displayed by the Manager application. The 
display name is also used in log files and reports to refer to this Monitoring Check. The 
display name can be any user friendly name. 

È Check every / Schedule this Check ï specifies how frequent a check will be scanned. You 
can set it to scan it at a specific date and time, or to scan it frequently with a specific interval. 

È Check fails after x errors in a row ï specifies the number of consecutive errors that must 
occur before a check will be considered as óFailedô; by default, a check will be considered as 
óFailedô after 3 consecutive errors. This option only applies to a check that is not scheduled. 

 

The configuration of checks is discussed in detail in Chapter 4: ñManaging Monitoring Checksò. 

3.7.  Options 

Options are properties that are global for all monitoring checks. 
You can configure these from the Tools menu, by selecting the Options item, or by pressing   
on the toolbar. 

Ƹ  Defaults 

óDefaultsô apply to new Monitoring Checks. Default values can be defined in the Options dialog: 
È On the Tools menu, click Options; 
È Select the Defaults tab. 

 
The following default values can be configured: 
È Check every x seconds/minutes/hours/days ï specifies how often a monitoring check 

routine will be scan for a new monitoring check; Initial default value: 30 seconds; 
È Check fails after x errors in a row (error threshold) ï specifies the number of consecutive 

errors that must occur before a new monitoring check will be considered as Failed; Initial 
default value: 3. 

 
Default values only apply to new checks; they do not affect existing monitoring checks. However, 
you can apply the default values to all monitoring checks by pressing the Copy/Paste Special 
from the Edit menu. 

Ƹ  Logging 

To configure logging, select the Options item from the Tools menu, and select the Logging tab; 
ActiveXperts Network Monitor maintains its own log files. By default, logging is enabled. To 
enable/disable logging: 
È Select/deselect the Enable Logging check box. 
 

By default, ActiveXperts Network Monitor only logs status changes. You may want to log all 
events. This can be achieved in the following way: 
È Select/deselect the Log all monitoring activities. 

 
ActiveXperts Network Monitor supports the following log file formats: 
È Plain Text log files, delimited by a configurable separator. This is the default log format. 

Logging information is written to the following directory by default:   
    T<installation directory> \ Logs T   
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È OLE DB compliant databases, including MS Access and MS SQL. OLE DB is also known as 
ADO. 

 
On Twww.activexperts.com/support/activmonitor/online/netmonlogging/ T (online Network Monitor 
Logging Guidelines) you can find information about configuring OLE DB (ADO) logging. The 
guidelines also explain how to migrate logging from MS Access to MS SQL, and how to 
troubleshoot OLE DB logging. 

Ƹ  Server Credentials 

By default, Network Monitor uses the Service Account credentials to monitor remote Windows 
servers. However, if these credentials do not have administrative permissions on a remote 
Windows server (for instance because the remote machine is member of another domain, or 
because the server is a standalone server) you can specify alternate credentials. These alternate 
credentials are administrated globally, and can be used in any Windows check.  

Ƹ  Date and Time 

Network Monitor does not use Windowsô Date/Time settings for displaying information, because 
results can be viewed by non-Windows users (Web interface, reports, etc.).Therefore, you can set 
Date/Time settings; these settings are stored in the configuration database, and will be used by all 
Manager applications, Web Views, Reports, etc.. 
 
To configure Date/Time settings: 
È On the Tools menu, click Options and select the Date and Time tab;  
È Select your preferred Time format and Date format. 

Ƹ  Auto Backup Settings 

Automatic Backup is enabled by default, and will backup the configuration file and all VBScript 
programs to a fixed network location automatically, periodically. For more details regarding Backup 
and Restore, please read chapter 3.17: ñBackup and Restoreò. 

3.8.  Notifications 

Notifications are sent in two situations: 
È When a Monitoring Check fails ï After a configurable number of errors (error threshold), the 

check is set to Failed. Probably you want to send notifications to the system operator via the 
SMS or e-mail to notify him that the server/device is down; 
By default, only one notification is sent after a failure; if you want to be notified regularly after 
a failure, it can be configured by pressing the Advanced button in the Monitoring Check 
Properties tab; 

È When a Monitoring Check is recovered from the Failed status ï ActiveXperts Network 
Monitor has the ability to repair a computer/device. It can be useful to send an alert to the 
operator to tell him that the previous error is no longer there. 

 
Notification Settings are software settings that are global for all monitoring checks. You can 
configure them from the Tools menu, by selecting the Notification Setup item, or by pressing   
on the toolbar. 

 

http://www.activexperts.com/support/activmonitor/online/netmonlogging/
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For all notification types - except pager notifications and SNMP traps - you can use an Address 
Book. In the Address Book, you can organize notification recipients in groups. Groups can be 
used in any check.But you can still define a custom list of recipients for individual checks. 
 
The following notification types are supported by ActiveXperts Network Monitor: 
È E-mail notifications; 
È Network notifications; 
È Alpha-numeric SMS notifications; 
È Numeric Pager notifications; 
È Alpha-numeric Pager notifications; 
È SNMP Trap notifications. 

Ƹ  Default notification settings for new Monitoring Checks 

Default notification settings apply to new Monitoring Checks. These values can be defined in the 
Notifications dialog: 
È On the Tools menu, click Notifications; 
È Select the Defaults tab. 

 
The following notification defaults can be configured: 
È Send E-mail notification when server goes offline ï this value indicates whether an e-mail 

notification should be sent when a check fails; 
È Send Email notification when server goes online ï this value indicates whether an e-mail 

notification should be sent when a check is successful after a failure; 
È Send SMS notification when server goes offline ï this value indicates whether an SMS 

notification should be sent when a check fails; 
È Send SMS notification when server goes online ï this value indicates whether an SMS 

notification should be sent when a check is successful after a failure; 
È Send Pager notification when server goes offline ï this value indicates whether a Pager 

notification should be sent when a check fails; 
È Send Pager notification when server goes online ï this value indicates whether a Pager 

notification should be sent when a check is successful after a failure; 
È Send SNMP Trap notification when server goes offline ï this value indicates whether an 

SNMP Trap notification should be sent when a check fails; 
È Send SNMP Trap notification when server goes online ï this value indicates whether an 

SNMP Trap notification should be sent when a check is successful after a failure; 
È Send Network notification when server goes offline ï this value indicates whether a 

network notification should be sent when a check fails; 
È Send Network notification when server goes online ï this value indicates whether a 

network notification should be sent when a check is successful after a failure; 
È Notification Frequency Defaults ï specifies how often a notification (e-mail, SMS and so 

on) should be sent after a failure. By default, a notification is sent only once after failure; 
however, you can configure to notify every x minutes after failure; 

È Action Frequency Defaults ï specifies how often actions (restart service, restart computer, 
run program, and so on) should be triggered after failure. By default, an action is triggered 
only once after failure; however, you can configure to trigger an action every x minutes after 
failure. 
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3.9.  E-mail Notifications 

To use SMTP e-mail notifications, the ActiveXperts Network Monitor service must have access to a 
SMTP server to send out e-mails. It can be any SMTP compliant mail server. You donôt need IIS to 
be installed. 
 

Note:  ActiveXperts Network Monitor doesnôt require IIS or an IIS SMTP connector; it 
communicates directly with the SMTP server using the SMTP protocol. 

 
 

ActiveXperts Network Monitor is compliant with SMTP servers that require SMTP authentication, 
like Microsoft Exchange. SMTP AUTH is the protocol that is used to verify that you are one of the 
users of the SMTP server. ActiveXperts Network Monitor is RFC 821 and RFC 822 SMTP AUTH 
compliant. 
It also supports multiple character sets, including English (ISO-8859-1), Chinese (big5) and 
Japanese (ISO-2202-JP). 

Ƹ  E-mail Notification Settings - General 

To quickly configure general e-mail notification settings, click Notification Setup   on the 
toolbar.  
To configure general e-mail notification settings: 
È On the Tools menu, click Notification Setup and select the E-mail tab; 
È Enable the Enable E-mail Notifications checkbox to enable e-mail notifications; 
È The SMTP mail server can be an IP address (like 10.0.0.1), a host name (like 

mail.mydomain.com) or a NetBIOS name (like EXCHANGE01); this is the server that will 
send out the actual notification messages to the recipients; 

È If your SMTP server requires authentication, click the authentication checkbox and provide 
a logon and password; 

È Provide Sender E-mail Address (required) and Senderôs Display Name (optional). The 
recipient will see this name/address as the sender, and all replies will be delivered to this 
mail account; 

È Use the E-mail Address Book to organize e-mail recipients in groups. The Address Book 
can be used for all checks. The E-mail Address Book makes configuration easier, because 
you donôt have to configure a separate list of recipients for each monitoring check; however, 
it is still possible to configure a separate list of recipient for any check; 

È Click on Format Message to edit the e-mail template and to enable/disable RTF (HTML) 
formatting. In this dialog, you can also set the preferred character set: English (ISO-8859-1), 
Chinese (big5) or Japanese (ISO-2202-JP). Enable RTF (HTML) formatting to support 
HTML tags. If you switch on RTF formatting, you must use the <br>  tag (or an alternative 
tag) to insert new lines. 

È Click on Secondary Server to specify a fallback server. The secondary server is only used if 
the primary SMTP mail server is down while attempting to send out an SMTP notification.  

 
To test the E-mail Notification Settings, use the Test SMTP Server button. It will send a request 
the Network Monitor Engine to send an E-mail message using the given settings. 
 
Message Templates are discussed in Chapter 3.14: ñMessage Templatesò. 
 

Note:  Be aware of e-mail clients that do not have Rich Text enabled for security reasons. For 
instance, Windows 2003 has the óRead all messages in plain textô option switched on in 
Outlook Express by default, so that incoming Rich Text messages may look garbled. 
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Ƹ  Using E-mail Notifications in a check 

For each check, you can make the following configuration settings: 
È Notify when check fails ï when the check is set to Failure, a message is being sent. 

Default: On; 
È Notify when a check recovers from a failed state ï when the check turns from Failure to 

Success, a message is being sent. Default: Off;  
È For both Success and Failure status changes, you use the Address Book recipient groups, 

or use a custom recipient list. 

3.10.  Network Notifications 

Network Notifications are the well-known óNet Sendô (or óNetPopupô) messages over the network. 
Only machines that support NetBIOS (like Windows and OS2) can send/receive these messages. 
NetBIOS messages can be sent to users and/or computers. 

Ƹ  Network Notification Settings - General 

To quickly configure general network notification settings, click Notification Setup   on the 
toolbar. 
To configure general network notification settings: 
È On the Tools menu, click Notification Setup and select the Network Popup tab; 
È Enable the Enable Network Popup Notifications checkbox to enable network notifications; 
È Use the Network Popup Address Book to organize NETBIOS recipients in groups. The 

Address Book can be used for all checks. The Address Book makes configuration easier, 
because you donôt have to configure a separate list of recipients for each monitoring check; 
however, it is still possible to configure a separate list of recipient for any check; 

È Click on Format Message to edit the network message template. Message Templates are 
discussed in Chapter 3.14: ñMessage Templatesò. 

 
To test the Network Notification Settings, use the Send Test Message button. It will send a 
request the Network Monitor Engine to send an network popup message using the given 
settings. 

Ƹ  Using Network Notifications in a check 

For each check, you can make the following configuration settings: 
È Notify when check fails ï when the check is set to Failure, a message is being sent. 

Default: On; 
È Notify when a check recovers from a failed state ï when the check turns from Failure to 

Success, a message is being sent. Default: Off;  
È For both Success and Failure status changes, you use the Address Book recipient groups, 

or use a custom recipient list. 
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3.11.  SMS Notifications 

ActiveXperts Network Monitor supports alpha-numeric SMS messaging in two ways: 
È Through a GSM Modem (or GSM phone), connected to the Network Monitor server by serial 

cable, Infrared or BlueTooth; 
È Via an SMPP SMSC service center. This requires ActiveXperts SMS Messaging Server on 

one of your network computers (or on the same machine as ActiveXperts Network Monitor). 

Ƹ  SMS Notification Settings - General 

To quickly configure general SMS notification settings, click Notification Setup   on the toolbar. 
To configure general SMS notification settings: 
È On the Tools menu, click Notification Setup and select the SMS tab; 
È Enable the Enable SMS Notifications checkbox to enable SMS notifications; 
È Choose Use GSM Modemé to send SMS notifications via a GSM modem, or choose Use 

ActiveXperts SMS Messaging Server to forward SMS notification requests to ActiveXperts 
SMS Messaging Server; 

È Click on the Format Message button to edit the SMS template. Message Templates are 
discussed in Chapter 3.14: ñMessage Templatesò. 

 

Ƹ  SMS Notification Settings ï GSM Modem (GSM Phone) 

In the GSM Modem setup dialog, you must select the Windows telephony device (recommended) 
or a physical COM port (directly) that is used to connect to the physical GSM modem. 
As soon as you select the device from the list, the Network Monitor Manager tries to detect the 
device connected to the Network Monitor server. If a GSM modem cannot be detected, a log file is 
provided for troubleshooting purposes.  
 
Use the Advanced Settings button to configure advanced communication settings.  
 

Ƹ  SMS Notification Settings ï ActiveXperts SMS Messaging Server 

ActiveXperts SMS Messaging Server is an SMS messaging framework to enable sending, 
receiving and processing of SMS messages. You can relay SMS notifications from any application 
(including Network Monitor) to the SMS Messaging Server. 
 
With ActiveXperts SMS Messaging Server, you can benefit from the productôs SMPP support. 
SMPP is the fastest and most reliable way of sending bulk SMS messages. 
 
To relay Network Monitor SMS notifications to ActiveXperts SMS Messaging Server, you must 
install the ActiveXperts SMS Messaging Server Client Tools on the server that has the Network 
Monitor service running. Once installed, you can select an SMPP channel (or a GSM channel). 
 

Ƹ  SMS Recipient Number 

The SMS recipient number must be in International Number Format: the SMS number, prefixed by 
the international dialing number and the '+' character. The use of the '+' character is required. For 
example: +4412345678 
 

http://www.activexperts.com/asmssrvr/
http://www.activexperts.com/asmssrvr/
http://www.activexperts.com/asmssrvr/
http://www.activexperts.com/files/asmssrvr/asmssrvr.exe
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Ƹ  Using SMS Notifications in a check 

For each check, you can make the following configuration settings: 
È Notify when check fails ï when the check is set to Failure, a message is being sent. 

Default: On; 
È Notify when a check recovers from a failed state ï when the check turns from Failure to 

Success, a message is being sent. Default: Off;  
È For both Success and Failure status changes, you use the Address Book recipient groups, 

or use a custom recipient list. 
 

Note:  To log all modem operations, you must enter a valid file name in the following registry 
entry: 
THKLM\ Software \ ActiveXperts \ Network Monitor \ Server \ Trace \ NotifySms  

3.12.  Pager Notifications 

ActiveXperts Network Monitor supports numeric DTMF Paging (using a Hayes compatible modem) 
and alpha-numeric paging (using an SNPP provider).  
 
The modem must be connected to the server where the Network Monitor Engine is running. When 
thereôs a failure, ActiveXperts Network Monitor uses the modem to dial-out to the Pager recipients. 
 

Ƹ  Pager Notification Settings - General 

To quickly configure general Paging notification settings, click Notification Setup   on the 
toolbar. 
To configure general Pager notification settings: 
È On the Tools menu, click Notification Setup and select the Pager tab; 
È Enable the Enable Pager Notifications checkbox to enable pager notifications; 
È Choose Use alpha-numeric pagingé to send alpha-numeric pager messages using an 

SNPP provider, or choose Use numeric DTMF pagingé to send numeric DTMF pager 
messages using a standard Hayes compatible modem. 

Ƹ  Pager Notification Settings ï alpha-numeric SNPP paging 

In the Pager/SNPP setting dialog: 
È Enter the Host (host name or IP address) of your SNPP paging provider. Enter the IP port 

used to connect to your SNPP provider (default: 444); 
È If your SNPP provider requires a password, enable the Password required option and 

provide a valid password. 
È In the Time-out field, enter the time-out (in millisecond) used to connect to the SNPP 

provider. 

Ƹ  Pager Notification Settings ï numeric DTMF paging using a modem 

In the Pager/DTMF setting dialog: 
È Select a Modem from the list. The list is inherited from the list of Telephone Devices of the 

operating system (configured in the Control Panel on the system where the Network Monitor 
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Engine is installed). If there is no modem driver installed for your device, you can also select 
a direct com port. Use the Test Pager Settings button to test the configuration; 

 

Note:  A Pager recipient can only consist of the following characters: 
T0,1,2,3,4,5,6,7,8,9,+, - ,*,#@,a,b,c,d,A,B,C,D,w ,WT 

 

Ƹ  Using Pager Notifications in a check 

For each check, you can make the following configuration settings: 
È Notify when check fails ï when the check is set to Failure, a message is being sent. 

Default: On; 
È Notify when a check recovers from a failed state ï when the check turns from Failure to 

Success, a message is being sent. Default: Off;  
È For both Success and Failure status changes, you use the Address Book recipient groups, 

or use a custom recipient list. 
 

Note:  To log all Pager operations, you can enter a valid file name in the following registry 
entry: 
THKLM\ Software \ ActiveXperts \ Network Monitor \ NotifyPager   

3.13.  SNMP Trap Notifications 

ActiveXperts Network Monitor supports SNMPv1 and SNMPv2c Trap notifications. 

Ƹ  SNMP Trap Notification Settings - General 

To quickly configure general SNMP Trap notification settings, click Notification Setup   on the 
toolbar. 
To configure general SNMP Trap notification settings: 
È On the Tools menu, click Notification Setup and select the SNMP Traps tab; 
È You can now configure a list of SNMP Traps. Usually, you will need just one trap to send out 

to a network management station, but you can define multiple traps. 
Press the Add Trap button to add a trap to the list; press the Edit Trap button to edit the 
parameters of a specific trap, and press the Remove Trap button to remove a trap from the 
list. 

È When you use the Add Trap button or the Edit Trap button, you can configure the parameters 
of a single trap. These parameters are described below. 

Ƹ  SNMP Trap Parameters 

A trap consists of the following parameters: 
È Agent ï the host name or IP address of the (remote) SNMP network management station; 
È Port ï the port used for sending SNMP traps; default: 162; 
È Community ï the community of SNMP devices. Default: public; 
È Protocol Version ï when you want to send a trap notification to an SNMPv1 compliant 

network management station, you must select SNMP v1. If the network management station 
runs SNMP v2c or higher, you must select SNMP v2c. Default: SNMP v2c; 
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È OID ï the Object Identifier; Network Monitor accepts numeric and alpha-numeric OIDôs, for 
instance: Tsystem.sysName.0, TorT 1.3.6.1.2.1.1.5.0 T; 

È OID Data Type ï this field indicates the type of data that is sent to the (remote) network 
management station. Network Monitor supports the following data types: strings, integers, IP 
addresses, time ticks, counter types, OIDôs and some other, less frequently used types; 

È OID Value ï the actual value that is sent over the network. You can include notification 
variables, like T<%DISPLAYNAME%>T , T<%TIME%>T, or T<%SERVER%>T. For a complete list of 
notification variables, see also Appendix C: ñNotification Variablesò; 

È Generic Trap ï this optional field is only used with SNMP v1.  
 

Ƹ  Using SNMP Trap Notifications in a check 

For each monitoring check, you can configure the following settings: 
È Notify when check fails ï when the check fails, a message is being sent. Default: On; 
È Notify when check recovers from a failed state ï when the check reverts to ósuccessô, a 

message is being sent. Default: Off;  
È For both Online and Offline status changes, you can choose to use Global SNMP Trap List 

as defined in the General SNMP Trap Notification Settings, or use a Custom SNMP Trap 
List. 

3.14.  Message Templates 

A notification message can be customized. Use the Format Message button in the appropriate 
general notification tab of the Notification Setup dialog from the Tools menu. Each notification 
type has its own message template. 
 
Inside a message template, you can use system variables. These variables are substituted each 
time the message is sent out. System variables must be enclosed between T<%T and T%>T strings, for 
example: T<% DATE %>. T See also Appendix C: ñNotification Variablesò for a complete list of 
Notification Variables. 

Ƹ  Message Template Example 

Example of a message template: 
 
Message from ActiveXperts Network Monitor  on <% SERVER %>, <% DATE %> <%TIME %>:  
 
Item:   <% DISPLAYNAME %> 

Result:  <% RESULT %> 

Explanation:<% EXPLANATION %>  

 
 

Note:  Using newlines in SMS Message Templates is NOT recommended. Many GSM 

phones donôt know how to handle newlines and will display bad characters. 
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3.15.  Maintenance  

To avoid notifications and actions during maintenance hours, you can configure maintenance 
schedules. All failures that happen during these schedules wonôt be notified, and no actions will be 
triggered. 
The maintenance schedules can be configured as Every Day of the Week, or as On This Date. 
 
To configure maintenance schedules: 
È On the Tools menu, click Maintenance; here, you see the list of configured schedules. You 

can define multiple schedules; 
È To add a new schedule, choose either Day of Week or This Date. 
In case of óThis Dateô, provide start date and time, and provide the number of hours the 
computer and devices will be unavailable; 
In case of óDay of Weekô, provide the days of the week that the computers and devices will 
be unavailable; also provide a start time, and provide the number of hours the servers will be 
unavailable. 

È Press the Add button to add the new schedule to the Maintenance Schedules list. 
 
By default, the maintenance schedules are inherited by all Monitoring Checks; however, you can 
configure maintenance schedules for each check individually in the Advanced tab of the 
Monitoring Check properties. Letôs say a company has maintenance on every Friday at 11:00 
pm for nearly all servers (use the global maintenance schedules for that). But for one server 
(server óAô), maintenance is scheduled on Saturday at 09:00 am. Configure individual maintenance 
schedules for server óAô.  

3.16.  Dependencies  

Dependencies allow you to create a hierarchy of checks that depend on each other. This hierarchy 
is not related to the Folder structure of your Network Monitor configuration. Dependencies prevent 
you and your network administrators from being overwhelmed with notifications when a central 
router or server goes down. Without a dependency configuration, the failure of a central server or 
device would cause a failure of other servers, and as a result many notifications would be sent out. 
There are at least two items involved when configuring dependencies: 
È Dependee - the computer/device that plays a central role. A failure of this 'Dependee' device or server 

would cause failures of other servers and devices (so called 'Dependers'); 
È Depender(s) - servers, devices or folders that depend on the 'Dependee'. 

 
A dependee cannot be a folder, only a check. You can make other checks and/or folders 
dependent on the Dependee. It is recommended to use Folders rather than Checks as a 
Depender, because it is dynamic. 
 
For more information about Dependencies, visit the Online Dependency Guidelines on the 
ActiveXperts web site. It contains a good sample and some best practice hints. 

3.17.  Backup and Restore 

The ActiveXperts Network Monitor configuration is stored in one single file: CONFIG.MDB. The 
CONFIG.MDB is located in the <Installation - Directory> \ Configuration  directory. 

http://www.activexperts.com/support/activmonitor/online/dependencies/
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Custom scripts are stored in the <Installation - Directory> \ Script s  directory. 
 
It is recommended to backup the configuration and custom scripts regularly. 

Ƹ  Manual Backup 

To backup the configuration manually, follow the instructions as described in Chapter 3.3 (óImport, 
Export and Clear configuration settingsô) of this manual. This chapter also describes how to restore 
the configuration manually. 

Ƹ  Automatic Backup 

Automatic Backup is enabled by default, and will backup the configuration file and all VBScript 
programs to a fixed network location automatically. By default, the backup is made on every 
Wednesday and Saturday, at 06:00am.  
 
To change the Auto Backup settings: 
È Select Options from the Tools menu, or press  on the toolbar. 
È Select the Auto Backup tab; 
È You can now Enable/Disable Auto Backup. When enabling Auto Backup, you must select at 

least one Day of the Week to schedule your backup. Choose a valid Destination Directory 
to backup your files to. It is recommended to choose a Network Location that is part of your 
daily overall backup procedure. 
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4.  Managing Monitoring Checks 

4.1.  Adding a New Check 

To quickly add a new Monitoring Check, click New Monitor Check   on the toolbar. 
To add a new Monitoring Check: 
È On the Monitor menu, click New Monitoring Check; 
È In the Check What drop-down box, select the type of check. In the next chapter, Monitoring 

Checks are described in more detail; 
È In the Display Name box, edit a custom display name; this name will also be used in the log 

files and reports; 
È In the Check every field, specify how often a check should run. By default, a check will be 

monitored once every 30 seconds. This default can be changed from the Options dialog in 
the Tools Menu. To use a scheduled check instead of running it at specific intervals, use the 
óSchedule this Checkô option (see below) instead of the óCheck everyô option; 

È In the Check fails after field, specify the number of consecutive errors that must occur 
before a check will be considered as Failed; by default, a check will be considered as Failed 
after 3 consecutive errors; 

È In the Schedule this Check fields, you can define at what times the check should run. 

4.2.  Copy/Paste a Check 

To quickly copy an existing Monitoring Check to the Clipboard, click Copy  on the toolbar. 
To copy an existing Monitoring Check: 
È On the Edit menu, click Copy; 
 

To quickly paste a Monitoring Check from the Clipboard, click Paste  on the toolbar. 
To paste a Monitoring Check: 
È On the Edit menu, click Paste; 
 

Note:  You can only copy one Monitoring Check to the clipboard at a time. 

4.3.  Deleting a Check 

To quickly delete an existing Monitoring Check, click Delete  on the toolbar. 
To delete an existing Monitoring Check: 
È On the Monitor menu, click Delete; 
È Confirm that you really want to remove the server from the configuration. 

4.4.  Editing a Check 

To quickly edit the Monitoring Check properties, right click on the Monitoring Check and choose 
properties, or double click on the Monitoring Check. 
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The Monitoring Check dialog will pop up. This dialog contains 4 tabs: 
È General Properties; 
È Notifications ï E-mail, SMS, Pager, SNMP Trap and Network/NetBIOS notifications; 
È Actions ï Run batch file, exe-file or VBScript programs; restart service(s) or reboot server; 
È Advanced Properties ï Configure Notification Frequency (re-notifications), Action 

Frequency (re-run programs), Maintenance hours and Dependencies. 

Ƹ  General Properties 

Select the General Properties tab, and configure the following fields: 
È Check What ï select the type of check, for instance: ICMP; 
È In the Display Name box, edit a custom display name; this name will also be used in the log 

files and reports; 
È In the Check every field, specify how often a check should run. By default, a check will be 

monitored once every 30 seconds. This default can be changed from the Options dialog in 
the Tools Menu. To use a scheduled check instead of running it at specific intervals, use the 
óSchedule this Checkô option (see below) instead of the óCheck everyô option; 

È In the Schedule this Check fields, you can define at what times the check should run; 
È In the Check fails after field, specify the number of consecutive errors that must occur 

before a check will be considered as Failed; by default, a check will be considered as Failed 
after 3 consecutive errors. 

Ƹ  Notifications Properties 

Select the Notifications tab, and configure the following fields: 
È E-mail: Notify when check fails ï If the check fails, send an e-mail notification to the 

selected recipients. The recipients are either defined in the global Address Book, or 
configured for this particular check only; 

È E-mail: Notify when check recovers from a failed state ï  If the check changes from 
Failure to Success, send an e-mail notification to the selected recipients; 

È Network: Notify when check fails ï If the check fails, send a network notification to the 
selected recipients; 

È Network: Notify when check recovers from a failed state ï  If computer /device turns 
from offline to online, send a network notification to the selected recipients; 

È SMS/Pager: Notify when check fails ï If the check fails, send an SMS notification to the 
selected recipients; 

È SMS/Pager: Notify when check recovers from a failed state ï  If computer /device turns 
from offline to online, send an SMS notification to the selected recipients; 

È SNMP Trap: Notify when check fails ï If the check fails, send an SNMP Trap notification to 
the selected recipients; 

È SNMP Trap: Notify when check recovers from a failed state ï  If computer /device turns 
from offline to online, send an SNMP Trap notification to an SNMP network management 
system. 

 
For all of the above items (except SNMP Traps), you can select recipient groups from the global 
Address Book.  
 
If you want to use different recipients (or traps) for a particular Monitoring Check, press the óéô 
button next to the corresponding item. 
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Ƹ  Actions 

You can define an action for each particular check. Actions are triggered when a check fails, or 
when a check recovers from a failure. There are no general settings for Actions; all settings are 
made in the properties of the monitoring check. 
 
There are 3 different types of actions: 
È Restart service 
After a failure, itôs possible to restart a service. For instance, if you canôt reach an IIS web 
server in your LAN, it may be a good idea to restart the W3SVC service.  You can use either 
the short service name (for instance W3SVC) or the long service name (for instance: World 
Wide Web Publishing Service). To restart multiple services, enter all services separated by a 
semicolon (ó;ô), for instance: alerter;browser; 

È Reboot computer 
In some situations, it may be useful to reboot a machine to try to recover from a failure; 

È Run Program 
You can configure to run a program after a failure has occurred. ActiveXperts Network 
Monitor supports three different types of programs: 
  - Executable files; 
  - Batch programs; 
  - VBScript programs. 
You can pass parameters to these programs on the command line. You can also use 
Notification Variables as parameters, as described in Appendix C.  

 
To configure Actions, select the Actions tab, and configure the following fields: 
È Run this program (.exe or .bat) when check fails ï If server/device goes offline, run the 

specified Win32 executable or batch file on the ActiveXperts Network Monitor server; 
È Run this program (.exe or .bat) when check recovers from a failed state ï If 

server/device turns from offline to online, run the specified Win32 executable or batch file on 
the ActiveXperts Network Monitor server; 

È Run this program (.vbs) when check fails ï If server/device goes offline, run the specified 
Visual Basic script on the ActiveXperts Network Monitor server; 

È Run this program (.vbs) when check recovers from a failed state ï If server turns from 
offline to online, run the specified Visual Basic script on the ActiveXperts Network Monitor 
server. 

È No reboot/restart after failure ï No reboot or restart of a service when failure occurs; 
È After failure, reboot computer ï Upon failure, reboot a particular server; 
È After failure, restart service(s) ï Upon failure, restart a service on a particular server. You 

can restart multiple services by providing a list of services. A list of services should contain 
individual services, separated by the ó;ô character. 

 
To restart a service or reboot a computer, the Network Monitor service credentials are used by 
default (i.e. the credentials used to start the ActiveXperts Network Monitor service, see also the 
ñServicesò applet in the ñAdministrative Toolsò folder). However, if a server is in a different domain 
or forest, and there is no trust, you may need to pass different credentials to restart or reboot.  
To do so, press the Credentials button and select an entry from the Alternate Credentials list. 
Alternate credentials are administrated globally (see also chapter 3.7: ñOptionsò) 

Ƹ  Advanced 

Select the Advanced tab to configure the following items: 
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È Notification Frequency ï This only applies to Failed checks. By default, notifications are 
sent only once after failure; if you prefer repetitive notifications, select the Notify every radio 
button and enter the notification frequency; 

È Action Frequency ï This only applies to Failed checks. By default, actions are invoked only 
once after failure; if you prefer repetitive actions, select the Trigger every radio button and 
enter the frequency; 

È Server Maintenance periods ï If you need Maintenance Schedules for a particular check 
other than the global Maintenance Schedules, you can configure it here. 

È Dependencies ï Read-only view of the dependencies for this check; 
È Check ID ï Each check has a unique ID. This ID is the key in the [Nodes] table of the 

configuration database (CONFIG.MDB). 

4.5. Monitoring servers in the same domain 

The ActiveXperts Network Monitor engine runs as a service on a Windows 
2008/Vista/2003/2000/XP operating system. This service run with Local System credentials or with 
Local/Domain Administrator credentials.  
 
To change the ActiveXperts Network Monitor service credentials: 
È Open the Computer Management application that is part of the Operating System; 
È Click on the Services applet; 
È Select the ActiveXperts Network Monitor service and click on the Log On tab;  
È Choose This Account and enter the Account and Password information. 

 
To monitor servers in a domain, enter an account that has Administration privileges on all domain 
members. A óDomain Administratorô or óEnterprise Administratorô account will suffice. You can use 
the UNC notation for the domain account, i.e.: DOMAIN\ Account . You can also use other dotted 
domain notations (mysubdomain.mydomain.dom \ Account ) or user principle names 
(j.doe@mydomain.do m). 

4.6. Monitoring servers in the other domains 

To monitor servers in another domain, ActiveXperts Network Monitor requires administrator rights 
on that domain. This can be established through a trust relationship between these domains. 
However, if there is no trust relationship, the service account credentials cannot be used. 
 
To monitor servers in another ï untrusted ï domain, you need to enter credentials for each 
Windows server in the Server Credentials table. See also Chapter 3.7: ñOptionsò. 
This also applies to stand-alone servers. 

4.7. Configuring a Check 

When you add a new Monitoring Check, you must select the type of Check. ActiveXperts Network 
Monitor supports a wide range of built-in checks. This paragraph describes how to configure each 
built-in check. 

mailto:j.doe@mydomain.dom
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4.7.1 IP-related checks 

Ƹ  DNS Server check 

ActiveXperts Network Monitor can resolve any DNS record and check the result against a specified 
value. Allowed record types include the óAô record, óMXô recordô and óCNAMEô recordô. 
A DNS Server check requires the following parameters: 
È DNS Server ï The IP address or hostname of the DNS server that you want to check; 
È Name ï The DNS name to resolve; 
È Type ï The DNS record type of the DNS record. Valid record type are: óA Recordô, óMX 
Recordô óCNAME Recordô or óAny Recordô;  

È IP address(es) ï The expected IP number(s). If the query result does not include the given 
IP address, the check will fail. Otherwise, the check will succeed. Please note that a DNS 
query can return more than one IP address. 
In case the óTypeô was set to óCNAME Recordô, the expected result is a host name, not an IP 
address. 

Ƹ  FTP check 

ActiveXperts Network Monitor can check the availability of an FTP site.  
You must pass credentials (username and password) to access the actual FTP site. If the FTP 
server allows anonymous access, specify óanonymousô in the óAccountô field, and specify a valid e-
mail address in the óPasswordô field.  
With the FTP check, you can check for a file in one of the subdirectories on the FTP server, and 
even check for a specific pattern in the file. 
 
An FTP check requires the following parameters: 
È Host ï Hostname or IP address of the remote FTP server. If the remote FTP server is listing 

on a port other than 21, you can append it to the host, like this: 192.168.0.1:23 
È Passive ï Specifies the way ActiveXperts Network Monitor establishes a connection with the 

FTP server: in Passive mode or in Active mode. Default: Passive. 
È FTP Account ï Account used to access the FTP server. You cannot leave it blank. If the 

FTP server allows anonymous access, you must specify óanonymousô in the óAccount fieldô 
and a valid e-mail address in the óPasswordô field; 

È FTP Password ï Account used to access the FTP server. If the FTP server allows 
anonymous access, you must specify óanonymousô in the óAccount fieldô and a valid e-mail 
address in the óPasswordô field; 

È Anonymous ï If the FTP server allows anonymous access, you can click on this check box 
to enter credentials automatically in the óAccountô and óPasswordô fields. The óAnonymousô 
property is not used by the engine; 

È Check Connectivity only / Check File Existence ï If you want to check availability only, 
you should select óCheck Connectivityô here. If you want to check for existence of a particular 
file, you must select óCheck File Existenceô; 

È Directory ï If you check for file existence, you can specify a working directory where the file 
indicated by the óFileô field should be located. Leave it blank to use the root of the FTP site as 
the working directory; 

È File ï The file you want to check; 
È Check file existence only / Check for a specific pattern in the file ï You can check for file 

existence only, or for a specific pattern in the file; 
È Use binary file transfer ï Indicates how the file should be transferred so it can be analyzed. 

Only possible if óCheck for a specific pattern in the fileô is selected; 
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Ƹ  TFTP check 

ActiveXperts Network Monitor can check the availability of a TFTP host by checking the existence 
of a file on the TFTP host. TFTP stands for óTrivial File Transfer Protocolô and is a forerunner of the 
FTP protocol. It has less functionality than FTP: it is based on the (unreliable) UDP protocol, has 
no support for directory browsing and has not protected by a logon and password. 
With the TFTP check, you can check for a file in a directory on the TFTP host, and check for a 
specific pattern in the file. 
 
A TFTP check requires the following parameters: 
È Host ï Hostname or IP address of the remote TFTP server. If the remote TFTP server is 

listing on a port other than 69, you can append it to the host, like this: 192.168.0.1:8069 
È File ï The file you want to check; 
È Check file existence only / Check for a specific pattern in the file ï You can check for file 

existence only, or for a specific pattern in the file; 
È Use binary file transfer ï Indicates how the file should be transferred so it can be analyzed. 
Only possible if óCheck for a specific pattern in the fileô is selected; 

È Pattern should match / Pattern should not match ï If the pattern is matched, then the 
result of the check can be either success or error. 

Ƹ  HTTP/HTTPs check 

ActiveXperts Network Monitor can check the availability of HTTP and HTTPs sites, on default ports 
(i.e.: 80 and 443) or on alternate ports.  
If the HTTP(s) server is not directly accessible, you can configure ActiveXperts Network Monitor to 
go through a Proxy server to access the particular HTTP(s) server, even passing credentials for 
that Proxy server (to be able to make use of the Proxy).  
Additionally, you can pass credentials (username and password) to access the actual HTTP(s) site 
if required. ActiveXperts Network Monitor supports web site content checking; contents of web 
sites can be searched for text patterns (including tags). 
 
An HTTP/HTTPs check requires the following parameters: 
È URL ï The location of the website in URL format (i.e. 

Thttp://server[:port]/path/... T format);  
È Require Server verification ï A flag to indicate: HTTP or HTTPs;  
È Check for availability only / Page must contain pattern / Page must not contain pattern 
ï In case of óCheck for Availability onlyô, only the availability of the site is checked. In case of 
óPage must (not) contain stringô, the content of the URL is checked for specific contents;  

È Time-out after ï Time-out in seconds. If the time-out expires, the result is óErrorô;  
È Use website authentication ï A flag to indicate whether authentication is required for the 
web site or not. If authentication is required, óWebsite Accountô and óWebsite Passwordô must 
be provided;   

È Website Account ï A valid account on the web site;   
È Website Password ï A valid password for the account on the web site; 
È Use a Proxy server ï A flag indicating whether the web site should be accessed through a 

Proxy server or not;   
È Proxy ï If the óUse a Proxy serverô field is set, this field indicates the actual Proxy server. A 

hostname, NetBIOS name or IP address is required here; 
È Proxy authentication ï If the óUse a Proxy serverô flag is set, and the proxy server indicated 
by the óProxyô field requires authentication, enable this check box;   

È Proxy Account ï A valid account on the Proxy server; 
È Proxy Password ï A valid password for the account on the Proxy server. 
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Ƹ  ICMP/Ping check 

ICMP Ping checks a remote host for availability. Local hosts should normally respond to ping 
requests within milliseconds. However, on a very congested network it may take up to 3 seconds 
or longer to receive an echo packet from the remote host.  
If the time-out is set too low under these conditions, it will appear that the remote host is not 
reachable (which is almost the truth). 
ActiveXperts Network Monitor checks servers for availability by sending ICMP Echo commands 
and wait for the responds. An ICMP time-out failure doesn't necessarily mean that the remote host 
is actually functioning beyond its ability to echo packets. 
 
An ICMP/Ping check requires the following parameters: 
È Host ï The DNS name or IP address of the computer you want to ping (can even be a WINS 

name, but only if the name can be resolved by some WINS server in the network);  
È Time-out after ï Maximum number of milliseconds it should take before a response is 

received; 
È Number of retries  ï The number of retries to send when a ping fails; 
È Time to Live ï Maximum Time to Live (TTL) value; 
È Buffer Size (bytes) ï Send buffer size. 

 

Ƹ  IMAP Mail Server availability check 

ActiveXperts Network Monitor can check IMAP mail servers by establishing a connection on the 
remote IMAP port (usually port 143) and do a handshake. By handshaking, ActiveXperts Network 
Monitor can verify that the remote server's IMAP protocol is working well. 
 
An IMAP Mail Server check requires the following parameters: 
È Host ï Hostname or IP address of the server to be monitored;  
È Port ï TCP port number of the IMAP protocol. Default: 143; 
È Send command when connected ï As soon as connection is established, send a 

command. By default, no command string will be sent; 
È Response must include string ï when connected, optionally send a command. Then wait 
for the response. The default response for IMAP servers includes: óIMAPô; 

È Time-out ï Number of milliseconds before the check will time-out. Usually, a connection to 
the server will be established within 1 second. However, some slow/busy servers need more 
time. Recommended value is 7000 milliseconds. 

Ƹ  LDAP check 

LDAP (Lightweight Directory Access Protocol) is a protocol for querying (and modifying) directory 
services like Microsoft Active Directory and Novell Netware. 

 
The LDAP check requires just one parameter: 
È LDAP Server ï Hostname or IP address of the server to monitor. 

 
The check will by default try to retrieve the full name of the queried directory service, and match 
the result against a pattern. One may check want to use more sophisticated queries; for this 
reason, the check is a VBScript check to allow customization. 
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Ƹ  NNTP News Server check 

ActiveXperts Network Monitor can check NNTP news servers by establishing a connection on the 
remote TCP port (usually port 119) and do a handshake. By handshaking, ActiveXperts Network 
Monitor can verify that the remote server's NNTP protocol is working well. 
 
An NNTP News Server Availability check requires the following parameters: 
È Host ï Hostname or IP address of the server to be monitored;  
È Port ï TCP port number of the NNTP protocol. Default: 119; 
È Send command when connected ï As soon as connection is established, send a 

command. By default, no command string will be sent; 
È Response must include string ï When connected, optionally send a command. Then wait 
for a response. The default response for NNTP servers includes: ó200ô; 

È Time-out ï Number of milliseconds before the check will time-out. Usually, a connection to 
the server will be established within 1 second. However, some slow/busy servers need more 
time. Recommended value is 7000 milliseconds. 

Ƹ  NTP Time Server check 

Commercial organizations today rely on networks of computers, all of which have clocks that are 
the source of time for files or operations they handle.  
Most of these organizations use a time server to ensure accurate time settings. The NTP protocol 
is the protocol used to synchronize times between workstations and servers, and external time 
sources. ActiveXperts Network Monitor uses the IP based NTP protocol to check availability of 
internal and external time sources. 
 
An NTP check requires one parameter: 
È Time Server ï Hostname or IP address of the time server. 

Ƹ  POP3 Mail Server check 

ActiveXperts Network Monitor can check POP3 mail servers by establishing a connection on the 
remote TCP port (usually port 110) and do a handshake. By handshaking, ActiveXperts Network 
Monitor can verify that the remote server's POP3 protocol is working well. 
 
A POP3 Mail Server Availability check requires the following parameters: 
È Host ï Hostname or IP address of the server to be monitored;  
È Port ï TCP port number of the POP3 protocol. Default: 110; 
È Send command when connected ï As soon as connection is established, send a 

command. By default, no command string will be sent; 
È Response must include string ï When connected, optionally send a command. Then wait 

for a response. The default response for POP3 servers is: ó+OK POP3ô; 
È Time-out ï Number of milliseconds before the check will time-out. Usually, a connection to 

the server will be established within 1 second. However, some slow/busy servers need more 
time. Recommended value is 7000 milliseconds. 

Ƹ  RADIUS check 

ActiveXperts Network Monitor can check RADIUS (Remote Authentication Dial In User Service) 
servers by authenticate a user.  
 
A RADIUS check requires the following parameters: 
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È RADIUS Server ï Hostname or IP address of the server to be monitored;  
È RADIUS UDP Port ï UDP port number of the RADIUS protocol. Default: 1812; 
È User ï User to authenticate against the RADIUS server; 
È Password ï Password of the user; 
È Time-out ï Number of milliseconds before the check will time-out.  

Ƹ  SMTP Mail Server check 

ActiveXperts Network Monitor can check SMTP mail servers by establishing a connection on the 
remote TCP port (usually port 25) and do a handshake. By handshaking, ActiveXperts Network 
Monitor can verify that the remote server's SMTP protocol is working well. 
 
An SMTP Mail Server check requires the following parameters: 
È Host ï Hostname or IP address of the server to be monitored;  
È Port ï TCP port number of the SMTP protocol. Default: 25; 
È Send command when connected ï As soon as connection is established, send a 

command. By default, no command string will be sent; 
È Response must include string ï when connected, optionally send a command. Then wait 
for the response. The default response for SMTP servers includes: ó200ô; 

È Time-out ï Number of milliseconds before the check will time-out. Usually, a connection to 
the server will be established within 1 second. However, some slow/busy servers need more 
time. Recommended value is 7000 milliseconds. 

Ƹ  SMTP to POP3 check 

This check verifies whether an e-mail service is working properly by sending a test e-mail message 
through an SMTP server and verifying that it has been delivered to the recipient's mailbox. 
 
An SMTP to POP3 check requires the following parameters: 
È E-mail Recipient ï E-mail address of the recipient to send the e-mail to;  
È Subject ï Subject of the e-mail. Note that the ActiveXperts engine will add a unique ID to it, 

to mark the e-mail as an SMTP to POP3 test mail; 
È SMTP Server ï select what SMTP server to use: the global primary SMTP server, the global 

secondary server, or another SMTP server; 
È POP3 Server ï the hostname or IP address of the POP3 server;  
È POP3 Account ï the account to authenticate to the POP3 server;  
È POP3 Password ï the password to authenticate to the POP3 server;  
È Check E-mail every ï check interval, in minutes;  
È Check fails if e-mail is not received within ï e-mail delivery time-out value. If the e-mail is 

not delivered to the POP3 box within the specified time, the check will fail;  
È Delete the mail after delivery ï Network Monitor can optionally delete the e-mail once is 

has been delivered. 

Ƹ  SNMP GET check 

SNMP  means: Simple Network Management Protocol. The SNMP GET message allows the 
Network Monitor Engine to request information about a specific variable on a remote computer or 
device. The agent, upon receiving a GET message, will issue a GET-RESPONSE message to the 
Network Monitor Engine with either the information requested or an error indication as to why the 
request cannot be processed. 
 
An SNMP GET check requires the following parameters: 
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È Host ï Hostname or IP address of the computer/device to monitor;  
È Port ï UDP port used for SNMP on the target machine/device. Default port is 161; 
È Community ï The SNMP community string; Default: ópublicô; 
È Protocol ï Indicates how the SNMP client should communicate with the remote SNMP 
agent. If you choose óAutomaticô, the SNMP agents on both sites will negotiate and use the 
preferred protocol. Choose óSNMPv1ô to force the agents to use SNMP version 1; choose 
óSNMP v2cô to force the agents to use SNMP version 2c; 

È OID (Numeric/Symbolic) ï The Object ID; the OID is a long numeric tag or a symbolic 
(friendly) name, used to distinguish each variable uniquely in the MIB and in SNMP 
messages. If you use the numeric tag format, the OID can be prefixed by a ó.ô. This is 
optional. For example: .1.3.6.1.2.1.1.5.0 or 1.3.6.1.2.1.1.5.0. 
Friendly names are names like: system.sysName.0, or 
interfaces.ifTable.ifEntry.ifOperStatus.1. 

È Select a symbolic OID from a MIB fileé ï Use this button to select an alpha-numeric OID 
from a MIB file. You can use virtually any 3rd-party MIB file; 

È OID Data Type ï The OID Data type. The following type are valid data types: Bit Stream, 
Counter, Integer, IP address, Object Identifier, Opaque String, String, Time Ticks and 
Unsigned Integer; 

È OID Data must be ï Choose the condition: Equal To, Not Equal To, Less Than, Less or 
Equal To, Greater Than, Greater or Equal To. This condition is used to compare the actual 
SNMP value against the óIOD Data Valueô; 

È OID Data Value ï OID value that will be compared against the actual OID value, using the 
óOID Data must beô operand; 

È AND / OR ï To extend the condition, use AND or OR operator. On selecting AND or OR, you 
must specify an additional condition (Equal To, etc.) and OID Data Value. 

Ƹ  SNMP Trap Receive check 

The SNMP Trap Receive check listens for real-time network traps for processing. The SNMP Trap 
Receiver must be enabled at a global level. To enable the SNMP Trap Receiver: 
È On the Tools menu, choose Options; 
È Select the Advanced Tab and click on the Configure SNMP Trap Receiver button; 
È Enable the Trap Receiver by enabling the Enable SNMP Trap Receiver checkbox. 

 
An SNMP Trap Receive check works different than other checks in Network Monitor: the SNMP 
Trap Receive check is event-driven. The check is not executed at timed intervals, but is triggered 
on a newly received trap. As a result, you cannot specify a time interval for SNMP Trap Receive 
checks. 
 
An SNMP Trap Receive check requires the following parameters: 
È Receive from Host ï Hostname or IP address of the computer/device to monitor. To specify 
any host, use ó*ô; 

È Receive OID ï The Object ID to receive. This can be a numeric OID or a symbolic OID. Type 
ó*ô to check for any OID; 

È Select a symbolic OID from a MIB fileé ï Use this button to select an alpha-numeric OID 
from a MIB file. You can use virtually any 3rd-party MIB file; 

È Receive OID Data Type ï The expected OID Data type. The following type are valid data 
types: Bit Stream, Counter, Integer, IP address, Object Identifier, Opaque String, String, 
Time Ticks and Unsigned Integer; 

È Match OID Value ï To check the OID data for specific value(s), enable this check box and 
configure the conditions in the same way as for the óSNMP GETô check.  
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Ƹ  TCP/IP check 

ActiveXperts Network Monitor can check local- or remote servers by challenging a specific port. It 
makes a connection to it, and performs a challenge/respond (by sending a sequence of bytes to it, 
wait for the respond and analyzing the received information). 
 
A TCP/IP check requires the following parameters: 
È Host ï Hostname or IP address of the server to be monitored;  
È Port ï TCP port number of the protocol to be checked; 
È Send command when connected  ï  As soon as connection is established, send a 

command; 
È Response must include string ï When connected, optionally send a command. Then wait 

for a response; 
È Time-out ï Number of milliseconds before the check will time-out. Usually, a connection to 

the server will be established within 1 second. However, some slow/busy servers need more 
time. Recommended value is 7000 milliseconds. 

 
 

4.7.2 Microsoft Windows-related checks 

Ƹ  Anti-Virus/Anti-Spam check 

The Anti-Virus check allows monitoring various popular Anti-Virus packages on workstations and 
servers. The following Anti-Virus software packages are supported:  
È McAfee VirusScan Enterprise; 
È Norton Internet Security; 
È Norton Anti-Virus; 
È NOD32; 
È Kaspersky Internet Security; 
È Kaspersky Anti-Virus Server; 
È Kaspersky Anti-Virus Workstation; 
È Trend Micro Internet Security; 
È Sophos Anti-Virus; 
È !avast Anti-Virus; 
È AVG Anti-Virus; 
È Norman Anti-Virus; 
È Panda Internet Security; 
È Norman Anti-Virus. 
 

An Anti-Virus/Anti-Spam check requires the following parameters: 
È Computer ï The NetBIOS name, DNS name or the IP address of the computer you want to 

monitor; 
È Check Software ï Type of Anti-Virus/Anti-Spam software you want to check for. 

 

The Anti-Virus/Anti-Spam checks are implemented as VBScript functions (ANTIVIRUS.VBS ). You 

can make modifications to the script, to enhance your Anti-Virus/Anti-Spam software checks. 

Ƹ  CPU Usage check 

ActiveXperts Network Monitor provides the óCPU Usageô check to monitor processor(s) on 
Windows platforms. When the CPU load exceeds the limit, an alert is generated. 
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For multi-processor systems, you can select to monitor all CPUôs (default) or monitor an individual 
CPU. 

 
A CPU Usage check requires the following parameters: 
È Computer ï The NetBIOS name, DNS name or the IP address of the computer you want to 

monitor; 
È CPU ï Select óAll CPUôsô or óThis CPUô; on a multi-processor system, you can monitor a 
specific CPU (óThis CPUô). To monitor all processors on a single- or multi-processor system, 
select óAll CPUôsô; 

È Max. CPU Usage ï Maximum allowed CPU usage (%). 
È Credentials ï Select alternate Windows credentials if necessary. 

Ƹ  Directory check 

You are running Windows Server and some of your users insist on copying the contents of their 
notebook computer to your file server. Other users want to download everything they see on the 
Web. Unfortunately, you're running out of disk space. Disk space is your serverôs most expensive 
subsystem, so itôs a good practice to monitor ï for instance - userôs Home Directories. The 
óDirectory checkô can be of good help. 

 
A Directory check requires the following parameters: 
È Directory ï The directory in UNC (óUniversal Naming Conventionô) format. For instance: 

\\server01\public\docs; 
È Check Directory Existence Only / Check Directory Size / Check File Count / Check 

Directory Content Change ï Select the type of Directory check; 
È Minimum/Maximum size ï Minimum or maximum size (MB) of the directory (only applicable 
if óCheck Directory Sizeô is selected); 

È Minimum/Maximum number ï Minimum or maximum of files in a directory (only applicable 
if óCheck File Countô is selected). If you want to count a directory as a file, select 'Also count 
a directory as a file'; 

È Include subdirectories ï select this option to include subdirectories in any type of directory 
check; 

È Credentials ï Select alternate Windows credentials if necessary. 

Ƹ  Disk Drives check 

ActiveXperts Network Monitor can monitor all physical disk drives on servers running the Windows 
operating system.  If a malfunctioning disk drive is detected on the computer, an alert is generated. 
 
A Disk Drive check requires the following parameters: 
È Computer ï The host name or the IP address of the computer you want to monitor; 
È Credentials ï Select alternate Windows credentials if necessary. 

Ƹ  Disk Space check 

The amount of free disk space is checked periodically, and if it drops too low you're immediately 
notified. It can also notify if used space gets too high. 
 
A Disk Space check requires the following parameters: 
È Computer ï The host name or the IP address of the computer you want to monitor; 
È Drive ï the drive letter as it appears on the remote server; 

file://server01/public/docs
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È Disk Space ï Maximum allowed space / Minimum required free space ï In case of 
óMinimum required free spaceô, the computer is checked for a minimum available space 
specified by the number of MBôs that you enter. In case of óMaximum allowed used spaceô, 
the computer is checked for a maximum used space specified by the number of MBôs that 
you enter; 

È MB / GB / % ï the upper/lower limit in Megabytes, Gigabytes or percentage; 
È Credentials ï Select alternate Windows credentials if necessary. 

 

Note:  The óDisk Spaceô check uses the systemôs administrative shares (i.e. C$, D$ etc.) to 
access drives on remote computers. For security reasons, these share are sometimes 
renamed by system administrators, for instance: MYCDRIVE$. You can type such a 
name in the selection box, and the Network Monitor Engine will use this administrative 
share name instead of the defaults administrative share name. 

Ƹ  Event Log check 

ActiveXperts Network Monitor can read Windows Event logs on local- or remote computers. It can 
look for specific Event Sources, Categories, Event ID's and so on. It can look for a pattern in the 
Description of the Event. 
It can do advanced filtering in Event Logs; it can look for multiple events in the Event Log, and 
notify the system administrator if one of the Events occurred in a specific time interval.  For 
instance, as a network administrator, you want an alert if there's a McAfee or Norton virus 
message in the Application Event Log, but only if the event is posted in the last 30 minutes. 
ActiveXperts Network Monitor uses VBScript and WMI for this.  
It enables you to fully customize Event Log filtering, speeding up performance by checking for 
more than one event in each cycle. 
 
An Event Log check requires the following parameters: 
È Computer ï The host name or the IP address of the computer you want to monitor; 
È Log File ï The Log File to be checked. Choose the appropriate log file, for instance: 
óApplicationô, óSecurityô, óSystemô, or server-related log (like DNS, Exchange, etc.); 

È Credentials ï Select alternate Windows credentials if required; 
È Information/Warning/é  ï Filter these event types; 
È Source ï Filter events that match this Event Source; 
È Category ï Filter events that match this Event Category; 
È ID ï Filter events that match this Event ID; 
È User ï Filter events that match this User; 
È Description matches string ï Filter events that match the description string in the Event 

Message; 
È Only Events from the last x minutes ï This options allows you to discard errors that 
happened in the past. For instance, if you donôt want to be notified about error events that 
happened in the past (like a week ago), use this option; 

È This check will fail if such event is found/not found  ï Specify whether this check will fail 
or succeed when an event is found. 

Ƹ  File check 

ActiveXperts Network Monitor can monitor file existence, file size and file content. This is 
particularly useful in situation where log files need to be analyzed. In many organizations, batch 
jobs run at night and produce logging information; ActiveXperts Network Monitor can check this 
logging information and analyze it. It can check the existence, or search for patterns. It can also 
check the size of a file. 
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A File check requires the following parameters: 
È File (UNC Path) ï The path of the file to be checked in UNC format (i.e. \\server\share\... 

syntax); 
È Check for: Existence only / Maximum Size / Pattern ï Choose an option: just checks the 

existence, or check the size of a file (in KB/MB), or search for a pattern in the file 
È If condition should be True/False ï If the file conditions are true, then the result of the 

check is: success; otherwise, the result will be: error; 
È Credentials ï Select alternate Windows credentials if necessary. 
 

Ƹ  Memory Usage check 

ActiveXperts Network Monitor can check the memory usage of the Windows Operating System. It 
can monitor the total available physical memory usage, the committed memory or the pages per 
second. 
 
A Memory Usage check requires the following parameters: 
È Computer ï Host name or IP address of the computer to monitored;  
È Memory ï select óMinimum required Available Physical Memoryô to check physical available 
memory; choose óMaximum allowed Committed Memoryô to check committed memory; 
choose óMaximum allowed Pages Per Secondô to check paging; 

È MB / Pages per Second ï enter the amount in MBôs (for the physical memory and 
committed memory checks) or number of pages per second; 

È Credentials ï Select alternate Windows credentials if necessary. 

Ƹ  MS Exchange Server check 

ActiveXperts Network Monitor monitors the status of the Exchange services, and monitors the 
most important performance counters. Among these performance counters are: performance 
counters for the Information Store, mailboxes, public folders and SMTP connector. If it drops too 
low you're notified immediately. 
One can extend the Exchange check function by checking more services and monitoring more 
performance counters. 
The following MS Exchange versions are supported: 2007, 2003, 2000 and 5.x. 
 
An MS Exchange Server check requires the following parameter: 
È Exchange Server ï The host name or IP address of the MS Exchange Server; 
È Exchange Server Version ï Version of Exchange Server. Can be either 2007, 2003, 2000 

or 5.5; 
È Credentials ï Select alternate Windows credentials if necessary. 
 

 

Ƹ  MS ISA Server check 

ActiveXperts Network Monitor monitors the status of the MS ISA Server services. It can monitor a 
caching-only ISA server, a firewall-only ISA server, or an integrated (caching+firewall) ISA server. 
The following MS ISA Server versions are supported: 2006, 2004 and 2000. 
 
An MS ISA Server check requires the following parameters: 
È ISA Server ï The host name or IP address of the ISA server; 
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È ISA Server Version ï Version of ISA Server. Can be either 2006, 2004 or 2000; 
È ISA Server Mode ï Specifies in what mode the ISA Server is running: Caching Only, 

Firewall Only, or Integrated (Caching + Firewall); 
È Credentials ï Select alternate Windows credentials if necessary. 

Ƹ  MS Message Queue (MSMQ) check 

ActiveXperts Network Monitor monitors the status of the MS Message Queueôs. It can check a 
queue for its length (i.e. number of jobs in the queue) or for its total size (MB). 
 
An MSMQ check requires the following parameters: 
È Server ï The host name or IP address of the server; 
È Queue Name ï Name of the MSMQ queue, for instance: private$ \ admin_queue$ ; 
È Maximum Queue Length ï Maximum number of jobs allowed in the queue; 
È Maximum Queue Size ï Maximum amount of MBôs in the queue; 
È Credentials ï Select alternate Windows credentials if necessary. 

Ƹ  MS SharePoint Server check 

ActiveXperts Network Monitor monitors the status of the MS SharePoint Server services. It can 
monitor the following MS SharePoint flavors: óMicrosoft Office SharePoint Portal Server 2007ô, 
óWindows SharePoint Services 3.0 (framework for MOSS 2007)ô, óMicrosoft Office SharePoint 
Portal Server 2003ô and óWindows SharePoint Services 2.0 (framework for MOSS 2003)ô. 
 
An MS SharePoint Server check requires the following parameters: 
È SharePoint Server ï The host name or IP address of the SharePoint server; 
È SharePoint Version ï Version of SharePoint Server. Can be either óMicrosoft Office 
SharePoint Portal Server 2007ô, óWindows SharePoint Services 3.0ô, óMicrosoft Office 
SharePoint Portal Server 2003ô and óWindows SharePoint Services 2.0ô; 

È Credentials ï Select alternate Windows credentials if necessary. 

Ƹ  MS Terminal Server check 

ActiveXperts Network Monitor monitors the status Terminal Server (part of 
Windows2008/Vista/2003/XP/2000) server by checking the number of active/inactive sessions. 
 
A Terminal Server check requires the following parameters: 
È Terminal Server Computer ï The host name or IP address of the Terminal Server 

computer; 
È Maximum number of Active Sessions ï Maximum active sessions; 
È Maximum number of Inactive Sessions ï Maximum inactive sessions, i.e. disconnected 

and idle sessions; 
È Maximum number of Sessions ï Maximum number of active and inactive sessions; 
È Credentials ï Select alternate Windows credentials if necessary. 

Ƹ  PowerShell check 

PowerShell is a command line interface shell for Microsoft Windows platforms: 
È It is a standard feature in Windows 7; 
È It is included with Windows 2008 but not installed by default; 
È It is available as a separate download for Windows 2003, Windows Vista and Windows XP; 
È It is not available for Windows 2000 platforms; 



  Chapter 4.  Managing Monitoring Checks 

   

      ActiveXperts Network Monitor      46 

È  PowerShell is not available for Windows 2000 platforms. 
 
ActiveXperts Network Monitor can check any Windows server by running a PowerShell script. The 
script is executed on the monitoring machine. Thereôs no need to have PowerShell installed on the 
monitored server; it must be installed on the monitoring computer. PowerShell scripts do not need 
to be copied to the monitored computer; you can have  all PowerShell scripts located on the 
monitoring computer to monitor remote computers. 
 
ActiveXperts Network Monitor ships with a collection of PowerShell (.ps1) that work out of the box. 
 
ActiveXperts Network Monitor requires the PowerShell script output (i.e. StdOut) to be formatted 
according to the following syntax: 
 

   [ SUCCESS | ERROR | UNCERTAIN]: { <explanation> } { DATA:<value>}  
 

The <explanation>  field is displayed in the óLast Responseô column in the Manager application. 

The <value>  field is displayed in the óDataô column in the Manager application. 

Samples: 
 

   ERROR: Free Disk space is less than 40 GB DATA:34  
   SUCCESS: CPU Usage is 10%, maximum allowed is 50%  DATA:10  

 
A PowerShell check requires the following parameters: 
È Script File ï The PowerShell script. The script is executed on the monitoring computer;  
È Parameter1 ï 1st argument of the function (optional); 
È Parameter2 ï 2nd argument of the function (optional); 
È Parameter3 ï 3rd argument of the function (optional); 
È Parameter4 ï 4th argument of the function (optional); 
È Parameter5 ï 5th argument of the function (optional); 
È Parameter6 ï 6th argument of the function (optional); 
È If StdErr is not empty, the result will be ï If thereôs an error in the script, you can handle 

this error and specify what the result of the check should be: Uncertain, Error or Success; 
È Time-out ï Number of milliseconds before the check will time-out.  
 

Ƹ  Printer Availability check 

Even the most mechanically sound printer stops working or needs maintenance from time to time:  
Printers run low on toner, run out of paper, or get jammed - unavoidable situations that prevent 
users from printing their documents. Unfortunately, when a printer stops working, no notice is sent 
to users; in addition, users can still send print jobs to the printer. If the problem is not identified and 
corrected, those jobs will continue to accumulate as long as the printer is unavailable. For these 
reasons, monitoring the printers in your organization is an important part of print management.  
With a well-designed monitoring strategy in place, you can receive timely notification whenever a 
printer stops functioning and take immediate steps to either get the printer back online or transfer 
print jobs to a different printer. 
ActiveXperts Network Monitor checks printers for availability by checking its status. Windows 
knows a wide range of printer status values,  like: 'Running', 'In Test', 'Power Off', 'Offline', 'Power 
Save', and so on.  
If the Printer Status is not equal to Running or Power Save, then the printer is considered as 
malfunctioning. 
 
A Printer Availability check requires the following parameters: 
È Print Server ï The hostname or IP address of the print server; 
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È Printer Name ï The name of the printer, as it appears in the Windowsô control panel. For 
instance: óHP LaserJet 2300 Series PSô; 

È Credentials ï Select alternate Windows credentials if necessary. 
 

Note:  The printer availability check is based on WMI, and only works on Windows 2000 
platforms or higher. 

Ƹ  Process 

ActiveXperts Network Monitor allows users to check processes on local- and remote computers; if 
a process is active, a computer is considered available. Additionally, memory usage of a process 
can be checked, to detect memory leaks. 
 
A Process check requires the following parameters: 
È Computer ï The host name or the IP address of the computer you want to monitor; 
È Process ï The module name of the process, including the extension. For instance: 

alerter.exe, or explorer.exe; 
È Check memory of this process ï Enable/disable memory checking of the particular 

process. Enter the maximum amount of memory (in MB) that a process may consume; 
È No process on this computer should consume more than ï Checks for any process 

using more than the specified amount of memory; 
È Credentials ï Select alternate Windows credentials if necessary. 

 

Note:  The process check is based on WMI; it requires WMI on both monitored and 

monitoring system. 

Ƹ  Remote Command  check 

ActiveXperts Network Monitor can check any Windows server by executing a command on a 
remote computer. The command file (executable, batch-job, etc.) must be located on the remote 
monitored computer.   

 
ActiveXperts Network Monitor requires the remote command output (i.e. StdOut) to be formatted 
according to the following syntax: 
 

   [ SUCCESS | ERROR | UNCERTAIN]: { <explanation> } { DATA:<value>}  
 

The <explanation>  field is displayed in the óLast Responseô column in the Manager application. 

The <value>  field is displayed in the óDataô column in the Manager application. 

Samples: 
 

   ERROR: Free Disk space is less than 40 GB DATA:34  
   SUCCESS: CPU Usage is 10%, maximum allowed is 50%  DATA:10  

 
A Remote Command check requires the following parameters: 
È Computer ï The host name or the IP address of the computer you want to monitor; 
È Command ï The command to execute on the remote computer. This command must reside 

on the remote computer; 
È If StdErr is not empty, the result will be ï If thereôs an error in the script, you can handle 

this error and specify what the result of the check should be: Uncertain, Error or Success; 
È Command Time-out ï Number of milliseconds before the command will time-out.  
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Note:  The Remote Command check installs a service on the remote computer in order to 
execute the command. This service is called óActiveXperts Remote Command serviceô; 
the associated executable name is óAxRemSvc.exeô.  
The service is uninstalled after the check has completed and is re-installed once the 
check is processed again. 

 

Ƹ  Scheduled Task 

With the Scheduled Task check, one can check if a scheduled task has completed successfully or 
not. A Scheduled Task check can only be applied to a task that should run today. I.e. you cannot 
check the completion of a task that ran ï for instance ï yesterday. 
 
A Scheduled Task check requires the following parameters: 
È Scheduled Task Log File ï the fully qualified path name to the Scheduled Task Log File 

(SchedLgU.txt ), in UNC format; for instance: 
\ \ Server01 \ C$\ Windows \ Tasks \ SchedLgU.txt  

Please note that this file is hidden in the Windows Explorer. Use a command prompt and 

type DIR C: \ WINDOWS\ TASKS to list the file; 

È Job Name ï Job name, as it appears in the SchedLogU.txt  file. For instance, job name 

should be mytask.bat  according to the following log entry: 
    "mytask.job" (mytask.bat)  

    Finished 1/19 /2006 1:43:00 PM  

    Result: The task completed with an exit code of (0).  

È Completed Keyword ï The keyword that determines the completion of a scheduled task. 

For many servers, the keyword will be Finished . However, the keyword can be different on 

non-English Operating Systems you are monitoring; 
È Todayôs Date Format ï The string that determines the date format used in the Scheduled 

Task Log File. Note that your network servers can use different time formats. For that 
reason, you must specify the date format, so Network Monitor will be able to find the log 

entries that match the day of today. Default format: mm/dd/yyyy , i.e. month (2 digits), day (2 

digits), year (4 digits), separated by a ó/ ô; 

È Match Result ï The string that indicates a successful/unsuccessful completion of the task.  
A successful completion is usually determined by the following string: 

Result: The task completed with  an exit code of (0) ;  

An unsuccessful completion is usually determined by the following string: 

Result: The task com pleted with an exit code of (1 ) ;  

Note that the string can be different on non-English platforms and on legacy (e.g. Windows 
NT 4) platforms; 

È If pattern matched, result is ï Indicates the result of the check if pattern is matched: 
Success or Error.  

Ƹ  Service 

Service monitoring involves a probe that returns the status of a service. ActiveXperts Network 
Monitor monitors services on local- and remote computers by checking if the status equals 
"Running". If so, the server is running fine, otherwise it's not. 
 
A Service check requires the following parameters: 
È Computer ï The host name or the IP address of the computer you want to monitor; 

file://Server01/C$/Windows/Tasks/SchedLgU.txt
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È Service ï The Windows service name. You can either the ófriendly nameô (as it appears in 
the Control Panel) or the óshort nameô (the registry key name in the 
HKLM\ System \ CurrentControlSet \ Services registry  hive); 

È Must run / Must not run ï Determines success or error of the check. If the service should 
NOT be running, select óMust not runô, otherwise select óMust runô; 

È Credentials ï Select alternate Windows credentials if necessary. 
 

Ƹ  VBScript 

ActiveXperts Network Monitor provides a programming interface to IT administrators. VBScript is 
the standard scripting language in ActiveXperts Network Monitor product. VBScript is the most 
popular scripting language in Windows environments. 
 
A VBScript check requires the following parameters: 
È File ï Name of the VBScript file. The script should contain a function as specified in the 

Function name field. This function should return True (-1) on success, False (0) on error or 
Unknown (1) in case the results is not known; 

È Function ï The function that should be called by ActiveXperts Network Monitor. This 
function should return True (-1) on success, False (0) on error or Unknown (1) in case the 
result is not known; 

È Parameter1 ï 1st argument of the function (optional); 
È Parameter2 ï 2nd argument of the function (optional); 
È Parameter3 ï 3rd argument of the function (optional); 
È Parameter4 ï 4th argument of the function (optional); 
È Parameter5 ï 5th argument of the function (optional); 
È Parameter6 ï 6th argument of the function (optional); 
È Advanced Settings:Time-out ï You can specify a time-out for a VBScript check. If the 

script takes longer than the time-out (in seconds), the function is aborted and an óUnknownô 
result is reported. By default, thereôs no time-out used; 

È Advanced Settings:Block script after a bad operation ï If a script crashes, for instance 
because of bad programming, you can block the script so that it will be executed the next 
time. By default, this option is enabled. 

 
Visit www.activexperts.com/support/activmonitor/online/vbscript/ for detailed information on writing 
custom VBScript checks. 

 
 

4.7.3 Linux / Unix checks 

Ƹ  SSH Shell Script 

SSH Secure Shell allows secure network services over an insecure network, such as the Internet. 
With SSH, ActiveXperts Network Monitor can login onto a remote machine running the SSH 
daemon, and execute a command or shell script. ActiveXperts Network Monitor requires the output 
(i.e. StdOut) to be formatted according to the following syntax: 
 

   [ SUCCESS | ERROR | UNCERTAIN]: { <explanation> } { DATA:<value>}  
 

The <explanation>  field is displayed in the óLast Responseô column in the Manager application. 

The <value>  field is displayed in the óDataô column in the Manager application. 

http://www.activexperts.com/support/activmonitor/online/vbscript/
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Samples: 
 

   ERROR: Free Disk space is less than 40 GB DATA:34  
   SUCCESS: Daemon óLPDô is running 
 

 
To allow clients (incl. ActiveXperts Network Monitor) to run a shell script on Linux/Unix machine 
using SSH, the following pre-conditions must be met: 
È The remote Linux machine must have the SSH daemon running; 
È The client must have an entry in the host.allowed  configuration file; 
È The shell script must be copied to the Linux machine first, i.e. it cannot be launched from a 

Windows machine. 
 
An SSH Shell Script check requires the following parameters: 
È Remote Host  ï Host name or IP address of the remote Linux/Unix host; 
È Port ï TCP port used for SSH on the remote host. Default port is 22; 
È SSH Command ï Specifies the command to run on the remote host; 
È Script Time-out ï Specifies the maximum number of milliseconds to wait for completion of 

the script; if the script takes longer, it will be terminated. Default value: 5000 milliseconds; 
È Account ï Account used to authenticate to the remote host; 
È Password ï Password used to authenticate to the remote host. If you use a Private Key File 
to authenticate, you can leave the óPasswordô field blank; 

È Private Key File ï Private Key File used to authenticate to the remote host. If you use a 
Password file to authenticate, you can leave the óPrivate Key Fileô field blank; 

È If StdErr is not empty, the result will be ï If thereôs an error in the script, you can handle 
this error and specify what the result of the check should be: Uncertain, Error or Success. 

Ƹ  RSH Shell Script 

RSH is a client process that opens connections to an rsh daemon; it sends a command to execute 
on the remote server and retrieves its output, both stdout and stderr. The connection is established 
on standard port 514 (tcp port for the shell/cmd protocol). ActiveXperts Network Monitor requires 
the output (i.e. StdOut) to be formatted according to the following syntax: 
 

   [ SUCCESS | ERROR | UNCERTAIN]: { <explanation> } { DATA:<value>}  
 

The <explanation>  field is displayed in the óLast Responseô column in the Manager application. 

The <value>  field is displayed in the óDataô column in the Manager application. 

Samples: 
 

   ERROR: Free Disk space is less than 40 GB DATA:34  
   SUCCESS: Daemon óLPDô is running 
 

 
To allow clients (incl. ActiveXperts Network Monitor) to run a shell script on Linux/Unix machine 
using RSH, the following pre-conditions must be met: 
È The remote Linux/Unix machine must have the RSH daemon running; 
È The remote Linux/Unix must have an entry in its .RHOSTS file for the computer where the 

ActiveXperts Network Monitor service is running on; this entry must include two values: the 
host name of the ActiveXperts Network Monitor server and the username to use. 

 
A RSH Shell Script check requires the following parameters: 
È Remote Host  ï Host name or IP address of the remote Linux/Unix host; 
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È RSH Username ï The username to use on the remote host. If not specified, the service 
account name will be used. The value must be configured in the .RHOSTS file on the remote 
host;  

È RSH Command ï Specifies the command to run on the remote host; 
È Script Time-out ï Specifies the maximum number of milliseconds to wait for completion of 

the script; if the script takes longer, it will be terminated. Default value: 5000 milliseconds; 
È If StdErr is not empty, the result will be ï If thereôs an error in the script, you can handle 

this error and specify what the result of the check should be: Uncertain, Error or Success. 
 

 

4.7.4 Database checks 

Ƹ  Database Query (Generic) 

ActiveXperts Network Monitor uses OLE DB (also known as ADO) to check availability of 
databases.  
OLE DB (sometimes written as OLEDB or OLE-DB) is an API for accessing different types of data 
stores in a uniform manner, including: MS SQL, MS Access, Oracle, MySQL and more. 

 
The Database Query check requires the following parameters: 
È OLE DB (ADO) Connection String ï The OLE DB connection string, for instance: 

DRIVER=Microsoft Access Driver(*.mdb);DBQ= \ \ SERVER03\ Public \ Northwind.mdb  
You can use a password in this connections string. To hide the password, you can use the 
<%PASSWORD%> placeholder. When using this placeholder, ActiveXperts will automatically 
substitute this placeholder with the óPasswordô field described below; 

È Password ï This is the password string (shown as asterisks) that will substitute the 
<%PASSWORD%> field described above; 

È Database Query ï The database query. The result of the check is determined by the result 
of this query; 

È Match Field ï The field that will be matched to determine the result of the check; 
È Type ï Type of field to be checked; 
È Field must be Equal To / Not Equal To / é ï Operator used to determine the result of the 

check; 
You can use an AND/OR operator to create an advanced condition. 

 

Note:  To check query results, you should use the custom VBScript database check. This 
check can be fully customized to meet your exact requirements. For instance, you can 
build complex queries, and analyze the query output. 
To create a new VBScript based database check, select óNew Monitoring Check 
(VBScript)ô from the Monitor menu, and choose Database.vbs . Edit Database.vbs  
to meet your requirements. 

Ƹ  ODBC Database 

ActiveXperts Network Monitor uses ODBC to check availability of a variety of databases. Most 
major database systems support ODBC, such as: Microsoft SQL Server, Microsoft Access, 
Microsoft Excel, Oracle, FoxPro, Paradox, SyBase, Informix, OpenIngres, InterBase, Progress, 
IBM LANDP, DB2 and AS/400. 
You must configure ODBC (from the Control Panel on the server where ActiveXperts Network 
Monitor is running on) before ActiveXperts Network Monitor can check ODBC compliant 
databases. 
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An ODBC check requires the following parameters: 
È ODBC DSN Name ï the ODBC DSN (Data Source Name). This DSN entry must be 

configured on the server where the ActiveXperts Network Monitor service is running; 
È Username/Login ï credentials required to access the database; 
È Password ï credentials required to access the database. 
 

ActiveXperts Network Monitor also provides Oracle checks based on SQLNet, like TNSPing and 
logon/logoff through SQLNet. 
 

Note:  The óADO / OLE/DBô check requires fewer configurations and is usually faster. As a 
result, it is the preferred way to check database, unless the database doesnôt ship with 
an OLE DB driver. 

 

Ƹ  Oracle Database 

ActiveXperts Network Monitor uses SQL*Net to monitor Oracle servers for availability. The role of 
SQL*Net is to establish and maintain a connection between the client application and the server 
and exchange messages between them. 
SQL*Net is a software layer that is required to communicate between Oracle clients and servers. It 
provides both client-server and server-server communications across any network. It enables client 
tools to access, modify, share, and store data on Oracle servers over a Network. 
The communication between client applications and servers takes place across one or more 
networks, and is referred to as client/server communication. 
 
ActiveXperts Network Monitor has two SQL*Net based checks for Oracle: 
È TNSPing check; 
È Logon/logoff to a database using username and password for that database. 

 
A Database-Oracle TNSPing check requires the following parameters: 
È Server TNS name ï TNS name of the Oracle database. 

 
A Database-Oracle Logon/Logoff check requires the following parameters: 
È Server TNS name ï TNS name of the Oracle database; 
È Username/Login ï credentials required to access the database; 
È Password ï credentials required to access the database. 
 
 

4.7.5 Environmental checks 

Ƹ  Temperature 

ActiveXperts Network Monitor requires an Environmental Monitor device from Sensatronics to 
monitor temperature. By using their server room temperature monitor in your data center design, 
you are taking a proactive approach in datacenter management. A managed environment can 
reduce IT server, storage and network outages by 50% or more.  
ActiveXperts Network Monitor supports the following Sensatronics models to monitor temperature: 
È Model Senturion (capable of monitoring temperature, humidity, wetness, power, light, motion, 

smoke, door, resistance, switch); 

http://www.sensatronics.com/
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È Model EM1 (capable of monitoring temperature, humidity and wetness); 
È Model CM16; 
È Model E16; 
È Model E8; 
È Model E4; 
È Model U16; 
È Model U4. 

 
A Temperature check requires the following parameters: 
È Host ï The host name or IP address of the network interface of the monitoring device; 
È Monitor Probe ï  Monitor different temperature locations, referred as 'Probe'; 
È Unit ï Select the preferred unit: Fahrenheit, Celsius, Kelvin or Rankine; 
È Minimum ï Minimum allowed temperature, in Fahrenheit or Celsius; 
È Maximum ï Maximum allowed temperature, in Fahrenheit or Celsius; 
È Enable Logging ï Allows you to log all probes. 

 
Data data can be logged to an ASCII log file or to an OLE DB (ADO) compliant database like MS 
Access or MS SQL.  
 

Ƹ  Humidity 

ActiveXperts Network Monitor requires an Environmental Monitor device from Sensatronics to 
monitor humidity. 
 
ActiveXperts Network Monitor supports the following Sensatronics models to monitor humidity: 
È Model Senturion (capable of monitoring temperature, humidity, wetness, power, light, motion, 

smoke, door, resistance, switch); 
È Model EM1 (capable of monitoring temperature, humidity and wetness). 

 
A Humidity check requires the following parameters: 
È Host ï The host name or IP address of the network interface of the monitoring device; 
È Monitor Probe ï  Monitor different locations, referred to as 'Probe'; 
È Minimum ï Minimum allowed humidity (%);  
È Maximum ï Maximum allowed humidity (%); 
È Enable Logging ï Allows you to log all probes. 

 
Data can be logged to an ASCII log file or to an OLE DB (ADO) compliant database like MS 
Access or MS SQL.  

 
 

 

Ƹ  Wetness 

ActiveXperts Network Monitor requires an Environmental Monitor device from Sensatronics to 
monitor humidity. 
 
ActiveXperts Network Monitor supports the following Sensatronics models to monitor wetness: 
È Model Senturion (capable of monitoring temperature, humidity, wetness, power, light, motion, 

smoke, door, resistance, switch); 
È Model EM1 (capable of monitoring temperature, humidity and wetness). 

 
A Wetness check requires the following parameters: 

http://www.sensatronics.com/
http://www.sensatronics.com/
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È Host ï The host name or IP address of the network interface of the monitoring device; 
È Monitor Probe ï  Monitor different locations, referred to as 'Probe'; 
È Minimum ï Minimum allowed wetness;  
È Maximum ï Maximum allowed wetness; 
È Enable Logging ï Allows you to log all probes. 

 
Data can be logged to an ASCII log file or to an OLE DB (ADO) compliant database like MS 
Access or MS SQL.  

 

Ƹ  Power, Light, Motion, Smoke, Door, Resistance, Switch checks 

ActiveXperts Network Monitor requires the Sensatronics Senturion device to monitor power, light, 
motion, smoke, door, resistance or switch. 

 
Such check requires the following parameters: 
È Host ï The host name or IP address of the network interface of the monitoring device; 
È Monitor Probe ï  Monitor different locations, referred to as 'Probe'; 
È Minimum ï Minimum allowed; 
È Maximum ï Maximum allowed; 
È Enable Logging ï Allows you to log all probes. 

 
Data can be logged to an ASCII log file or to an OLE DB (ADO) compliant database like MS 
Access or MS SQL.  

 

4.7.6 Miscellaneous checks 

Ƹ  Serial Device check 

ActiveXperts Network Monitor allows you to query a serial device (e.g. a modem, a weight 
indicator, etc.) and analyze the response. The device must have a serial port interface, for instance 
an RS-232 interface. USB devices are also supported, but only if the device ships with a driver to 
emulate a serial port. 

 
A Serial Device check requires the following parameters: 
È Device ï Device driver to use. You can either use a Windows telephony device 

(recommended) or a physical COM port (directly); 
È Flow Control ï Select the type of flow control to use. The following values are valid: Default, 

None, Hardware, Hardware+Software. You can only select óFlow Controlô if óDeviceô is set to 
a direct port (i.e. not a TAPI device);  

È Baudrate ï Select the baudrate (port speed). You can only select óBaudrateô if óDeviceô is set 
to a direct port (i.e. not a TAPI device);  

È Send command when connected  ï  As soon as connection is established, send a 
command; 

È Response must include string ï Expected response; 
È Time-out ï Number of milliseconds before the check stop reading information from the 

device.  
 

http://www.sensatronics.com/products_senturion.html
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Ƹ  Users & Groups 

ActiveXperts Network Monitor monitors groups and group membership. In case of unexpected 
members in certain groups (for instance: unexpected Domain Admins members), it'll notify the 
network administrators. 
 
ActiveXperts Network Monitor checks different kinds of Directory Services, for instance: Active 
Directory, or Novell NDS. 
You can configure ActiveXperts Network Monitor to check user accounts (locked out, disabled, 
etc.), groups, group membership, organizational units, and so on. 
 
The User/Group Membership check requires the following parameters: 
È Domain ï The Active Directory domain. In case you want to monitor a stand-alone server 

(i.e. a server not member of a domain), you can enter the computer name; 
È Group ï The group name to the Active Directory group you want to check, like: Domain 

Admins ; 
È Users ï Specify the names of the users that are allowed in the specified group. If the groups 
appears to have members who are not entered in this óUsersô field, the check will fail.  

4.8.  Writing your own monitoring checks using VBScript 

ActiveXperts Network Monitor contains a comprehensive set of built-in monitoring checks. The 
product is designed to let operators write their own monitoring checks and use them in the product. 
ActiveXperts uses VBScript because it is the most popular scripting language in Windows 
environments. 
 
ActiveXperts ships with a collection of cooked VBScript files and routines. These scripts are 
located in the Scripts \ Monitor  folder, and can be used out of the box. Feel free to modify 
these scripts. 
 
VBScript check routines should return one of the following values: 
È -1 (True); Return -1 in case the check is successful. For instance, if your function checks the 

existence of a certain directory, and it does exist, then return -1;  
È 0 (False); Return 0 in case the check is not successful. For instance, if your function checks 

the existence of a certain directory, and it does not exist, then return 0; 
È 1 (Unknown); Return 1 in case the check cannot determine True or False. For instance, if 

your function checks the existence of a certain directory on a server, but it cannot find the 
server at all (for instance because the computer is down), return 1; 

 
Keep the following in mind when writing a new VBScript function: 
È The routine must be a Function , not a Sub; 
È The Function must return True  (-1), False  (0) or Unknown (1); 
È The SYSEXPLANATION and SYSDATA variables must be declared (e.g. óDimmedô) because 

they are used internally by ActiveXperts Network Monitor; 
È Use the SYSEXPLANATION system variable to add your own explanation to the result of the 

function; this SYSEXPLANATION is shown in the client program each time the check is made; 
È Use the SYSDATA system variable to store any relevant data, if any. This data field is also 

shown in the Manager (óDataô column) and is also written to the log files; 
 
 

Function template: 
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Const retvalUnknown = 1  
Dim SYSDATA, SYSEXPLANATION 
 
Function Foo( var1, var2, ..., varn )  
   If( Not Pre - condition ) Then  
      SYSEXPLANANTION = "Unable to determine..."  
      Foo = retvalUnknown  
   Else  
      If( condition ) Then  
         SYSEXPLANANTION = "Yes it is true because ..."  
         SYSDATA = 5  
         Foo = True  
      Else  
         SYSEXPLANANTION = "No itôs not true because ..." 
         SYSDATA = 6  
         Foo = False  
      End If  
   End If  
End Function   

 
 
To add a VBScript check: 
È From the Monitor menu, choose New Monitoring Check (VBScript)é; 
È Select a VBScript File and a VBScript function; 
È Enter the required parameters and press OK. 

 
To create a new VBScript file, choose Create New Fileé from the File selection box and a new 
file will be created. 
To create a new function in a VBScript file, choose Add New Functioné from the Function 
selection box and a new function will be written. 

Ƹ  WMI (Windows Management Instrumentation) 

If you plan to write check routines based on WMI (Windows Management Instrumentation), be sure 
you have WMI installed on the ActiveXperts Network Monitor server and on the server that you 
want to monitor. 
WMI is part of the Windows 2008/Vista/2003/2000/XP operating system by default; For WMI for 
Windows NT4/98/ME, please check the Microsoft website; WMI is available for free. 
ActiveXperts has collected more than a hundred WMI samples. You can use these samples as a 
base for your new check routines. You can find these samples at 
www.activexperts.com/activmonitor/windowsmanagement/wmi/samples. 

Ƹ  ADSI (Active Directory Service Interfaces) 

If you plan to write check routines based on ADSI (Active Directory Service Interfaces), be sure 
you have ADSI installed on the ActiveXperts Network Monitor server and on the server that you 
want to monitor. ADSI allow you to access not only Windows 2000 Active Directory, but also NT4 
User information from the SAM database, and other User Databases like Novell Bindery and so 
on. 
ADSI is part of the Windows 2000 operating system; itôs not part of NT4. For NT4, please check 
the Microsoft website; ADSI is available for free. 

thttp://www.activexperts.com/activmonitor/windowsmanagement/wmi/samples
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ActiveXperts provides some useful ADSI scripts on their website, at 
www.activexperts.com/activmonitor/windowsmanagement/adsi/samples. You can use these 
samples as a base for check routines that you write yourself. 

Ƹ  VBScript troubleshooting 

Itôs recommended to write and test a custom script as a batch job first, before integrating the script 
in the Network Monitor software. It is important to write bug-free scripts; a script that is poorly 
written may block all VBScript based checks at the end. ActiveXperts Network Monitor has a multi-
threaded engine, and is capable of processing eight VBScript checks simultaneously. However, 
when all VBScript threads are blocked, thereôs no way the Network Monitor can check other 
VBScript based checks. 
 
UGeneral VBScript Guidelines: 
 
1. Location of the script 
 
The batch script must be located in the ActiveXperts Network Monitor installation directory or one 
of its sub-directories; 
 
2. Use a batch script to test the script 
 
Before integrating the script in the Network Monitor software, test it as a batch job first.  
 
Example:  

Option Explicit  
Const retvalUnknown = 1  
Dim SYSDATA, SYS EXPLANATION 

 
Function IsWeekend()  
    If WeekDay( Date() ) = VBSaturday or WeekDay( Date() ) = VBSunday Then  

        SYSEXPLANATION = "Yes, weekend"  
        IsWeekend = True  
    Else  

        SYSEXPLANATION = "No, no weekend"  
  IsWeekend = False  
    End If  

End Function  
 

Wscript.Echo "IsWeekend: " & IsWeekend()  ' Use Wscript ONLY for testing  

 (NOTE: the piece of code in green is the code that will be copied to the Network Monitor script when tested well) 

 
 Save this file as a . vbs  file, for instance: te st.vbs.  
 Then, run it from the command-line like this: 
 CSCRIPT TEST.VBS 
 

 
3. Donôt use WScript objects in your scripts 
 
Any commands and functions related to a console or User Interface should be avoided. Keep in 
mind that the Network Monitor Engine runs as a service, and has no user interface. Message 
boxes and console output statements may lead to undesirable results. Some objects will not work 
in Network Monitor: 
È Wscript object; 
È WshArguments object; 
È WshEnvironment; 

http://www.activexperts.com/activmonitor/windowsmanagement/adsi/samples
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È WshNamed; 
È WshNetwork; 
È WshRemote and WshRemoteError; 
È WshScriptExec 

È WshShell 
È WshSpecialFolders; 
È WshUnnamed; 
È WshUrlShortcut. 

Also, avoid functions that display a dialog box, like InputBox. 
 
 
4. Using the ActiveXperts VBScript debugger object 
 
ActiveXperts Network Monitor includes a debug control to print debug information to a log file while 
the Network Monitor Engine interpreter runs the script. The debug control is called 
TActiveXperts.VbDebugger T.  
 
TActiveXperts.VbDebugger T has the following properties: 
È TDebugFile T ï the name of the debug output file. The path of the file must be a valid path. If 

the file does not exists, the file will be created. 
 
TActiveXperts.VbDebugger T has the following functions: 
È TClearDebugFile T ï this function creates a new, empty TDebugFile T. Use it to clear debug 

output from a previous debug session; The function has no parameters; 
È TWrite T ï this function writes a piece of text to the TDebugFile T. The functions requires one 

parameter: the string to write to the file. If you want a newline at the end, you must pass it 
manually yourself as part of the parameter, or use the TWriteLine T function; 

È TWriteLine T ï this function writes a piece of text to the TDebugFile T, including a newline at 
the end. The functions requires one parameter: the string to write to the file;  

È TSlee p T ï this function will hold the script for some milliseconds. The function requires one 
parameter: the number of milliseconds.  

 
 The following sample shows how to use the debug control: 

Function IsWeekend()  
    Set objDebugger = CreateObject( "ActiveXper ts.VbDebugger" )  
    objDebugger.DebugFile = "c: \ temp \ debug.txt"  
    objDebugger.ClearDebugFile  ' Clear the file is desired  

    objDebugger.Write "Function WeekDay will be called now... " & vbCrLf  
    If WeekDay( Date() ) = VBSaturday or WeekDay( Date() )  = VBSunday Then  
        SYSEXPLANATION = "Yes, weekend"  

        IsWeekend = True  
    Else  

     SYSEXPLANATION = "No, no weekend"  

        IsWeekend = False  
    End If  
    objDebugger.Sleep 3000 ' Hold the script for three seconds  

    objDebugger.Write "Exi t IsWeekend" & vbCrLf  

End Function  

 

Ƹ  Online ActiveXperts VBScript Guildelines 

Visit www.activexperts.com/support/activmonitor/online/vbscript/ for detailed information on writing 
custom VBScript checks. It contains detailed information about writing custom scripts, describes 
the debugger and contains various samples. 

http://www.activexperts.com/support/activmonitor/online/vbscript/
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4.9.  Writing your own monitoring checks using a Linux/Unix Shell Script 

The Secure Shell Script (SSH) check allows you to login to a Linux/Unix host and run a shell script 
in a secure way. There are two ways to login: using an account and a password, or using an 
account and a private key file. 
 
ActiveXperts Network Monitor requires the output (i.e. StdOut) to be formatted according to the 
following syntax: 
 

   [ SUCCESS | ERROR | UNCERTAIN]: { <explanation> } { DATA:<value>}  
 

The <explanation>  field is displayed in the óLast Responseô column in the Manager application. 

The <value>  field is displayed in the óDataô column in the Manager application. 

Samples: 
 

   ERROR: Free Disk space is less than 40 GB DATA:34  
   SUCCESS: Daemon óLPDô is running 
 

Sample Shell Script to check directory existence: 
     

#!/bin/sh  

 

# Macro definitiions  

FREE=`free - m | awk '/^Mem:/  { printf( "%s \ n", $4 ); }'`  

USED=`free - m | awk '/^Mem:/  { printf( "%s \ n", $3 ); }'`  

 

# Validate number of arguments  

if [ $# - ne 2 ] ; then  

    echo "UNCERTAIN: Too few arguments Usage: memory <free>|<usage> <size>";  

    exit 1;  

fi  

 

# Validate arguments  

if [ $1 != "free" ] && [ $1 != "used" ]; then  

   echo "ERROR: Wrong parameters entered  DATA:0";  

fi  

 

# Check free memory  

if [ $1 == "free" ] ; then  

   if [ $FREE - gt $2 ]||[ $FREE == $2 ] ; then  

      echo "SUCCESS: Free memory is [$FREE MB], minimum required=[$2 MB] 

DATA:$FREE";  

   else  

      ec ho "ERROR: Free memory is [$FREE MB], minimum required=[$2 MB] 

DATA:$FREE";  

   fi   

fi   

 

# Check used memory  

if [ $1 == "used" ] ; then  

   if [ $USED - lt $2 ]||[ $USED == $2 ] ; then  

      echo "SUCCESS: Used memory is [$FREE MB], maximum allowed=[$2 MB] 

DATA:$FREE";  

   else  
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      echo "ERROR: Used memory is [$FREE MB], maximum allowed=[$2 MB] 

DATA:$FREE";  

   fi   

fi  

 

 
 
ActiveXperts Network Monitor ships with a selection of monitoring checks implemented as shell 

scripts.  These script are locatied in the following directory: \ Scripts \ Monitor (Linux)  
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5.  Managing Folders 
 
In ActiveXperts Network Monitor, all checks are organized into folders. Folders can be used in the 
Web Interface (to show only checks located in a particular folder), in Reports (to create reports of 
check within particular folders) and in Dependency relationships.  

5.1.  Adding a new Folder 

To add a new folder: 
È On the Monitor menu, choose New Folder; 
È In the Name field, type the name of the new folder. 

5.2.  Editing a Folder 

To edit a folder: 
È Select the Folder you want to edit; 
È Choose Properties from the Monitor menu; 
È Type a new name for the folder. 

5.3.  Deleting a Folder 

To quickly delete a folder, select the appropriate folder and click Delete  on the toolbar. 
To delete a folder: 
È Select the Folder you want to delete; 
È Choose Delete from the Monitor menu. When you delete a folder, all check routines and 

sub-folders in the folder tree will also be deleted. 
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6.  Web Interface 

6.1.  Introduction 

The ActiveXperts Network Monitor Web Interface is a collection of web pages, also called Web 
Views. 
Web Views are web pages, generated by the Network Monitor Engine, to provide a user interface 
to users who do not have the Network Monitor Manager installed. An Internet Browser can be used 
to view the status of the network. 
Web Views are based on XML/XSL technology. Web Views require Internet Explorer 6.x or higher, 
or any other web browser that is capable of parsing XML files. 
 
XML stands for Extensible Markup Language. It's a markup language much like HTML. The big 
difference is, that XML was designed to describe data; HTML was designed to display data. 
XML tags are not predefined. ActiveXperts Network Monitor defines its own tags for their Web 
Views. 
The World Wide Web Consortium (W3C) started to develop XSL because there was a need for an 
XML based Style sheet Language.  
XSL can transform XML into HTML, filter and sort XML data, define parts of an XML document, 
format XML data based on the data value, and more. This is exactly how Web Views work in 
ActiveXperts Network Monitor. 
 
It is important to understand that XML is not a replacement for HTML; XML is a cross-platform, 
software and hardware independent tool for transmitting information. 
The tags used to mark up HTML documents and the structure of HTML documents are predefined. 
The author of HTML documents can only use tags that are defined in the HTML standard (like 
T<p>, T T<h1>T, etc.). XML allows ActiveXperts Network Monitor to define his own tags and his own 
document structure; the tags are described in the section óXML Tags in Web Viewsô in this section. 
 
Web Views are preferred over the ActiveXperts Network Monitor Manager application when: 
È User requires read-only access to ActiveXperts Network Monitor;  
È User monitors remotely through a firewall; Web Views only requires access on one port (for 

instance, port 80); 
È User monitors multiple networks, with different Network Monitor configurations; 
È User needs access to ActiveXperts Network Monitor from any place in the organization; for 

instance, the HelpDesk staff can access Network Monitor from any workstations in the 
organization; 

È User is using a thin-client box, like a Windows CE based Wyse Terminal; 

6.2.  Using the Web Interface 

The ActiveXperts Network Monitor software is delivered with a pre-defined set of Web Views. To 
view these Web Views: 
È In the Tools menu, point to Web Interface and select Web Interface (default page); 
È The Web Interface default page is launched, where you can click on a particular Web View. 
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Note:  You need an XML capable browser to make use of the Web Interface, like Internet 
Explorer 6.x or Firefox 1.5. 
XSL in Internet Explorer 5 is NOT compatible with the official W3C XSL 
Recommendation. When Internet Explorer 5.0 was released in March 1999, the XSLT 
standard was still a W3C Working Draft. Since the final W3C XSL Recommendation is 
different from the Working Draft, the support for XSL in IE 5 is not 100% compatible 
with the official XSLT Recommendation. This restriction applies to both IE 5.0 and IE 
5.5. 

 

6.3.  Customizing the Web Interface 

Ƹ  Web Interface Configuration Tool 

Use the Web Interface Configuration Tool to customize the Web Interface. Use it also to create, 
modify or delete Web Views. 
 
To launch the Web Interface Configuration Tool: 
È In the Tools menu, point to Web Interface and select Web Interface Configuration Tool; 

 
With the Web Interface Configuration Tool, you can configure the following items: 
È Enable Web Interface ï by default, Web Views are enabled. Disabling the web interface will 

slightly improve the performance of the Network Monitor service; 
È Generate Web Views every x seconds ï Web Views refresh rate;  
È Installed Web Views - Each Web View consist of one XML file and a related XSL file. The 

XSL is the Style Sheet, and is not generated by the software; you can customize the Web 
View by modifying the XSL file.  
Each XML file is generated by the Network Monitor service; it will contain all monitoring 
results, and has a reference to the corresponding XSL file. 

 
You can add, delete and edit Web Views at any time. A restart of the Network Monitor service is 
not required. 

Ƹ  Publishing the Web Interface using IIS 

It's recommended to publish the XML pages through IIS, but they can also accessed directly by 
UNC path. You can manually configure IIS to provide the ActiveXperts Network Monitor pages in 
the following way:  
È Click Start, point to Administrative Tools and click on Internet Information Services (IIS) 

Manager to open the IIS Management Console; 
È Create a new web site by choosing New Web Site; 
È Provide a description and port number; 
È Provide a path name. Either use a local path (like TC: \ Program 

Files \ ActiveX perts \ Network Monitor \ Web  ) or an UNC path (like 
T\ \ SERVER01\ AXNetMon\ Web T ); 

È Finish the web site creation wizard. Then choose Web Site 'Properties', select the 
'Documents' tab and add the file, for instance TWebView1.X ml T; 



  Chapter 6.  Web Interface 

   

      ActiveXperts Network Monitor      64 

Ƹ  Web Interface XML tags 

Appendix B: ñWeb Interface XML Tagsò describes the XML tags in the web interface XML pages.  



  Chapter 7.  Report Module 

   

      ActiveXperts Network Monitor      65 

7.  Report Module 

7.1.  Introduction 

With the ActiveXperts Report Module, you can create reports over a specified period of time,  
Reports can either be run ad hoc, or they can be scheduled from the Windows Task Scheduler, 
which will run them automatically, periodically (, e.g. daily, weekly or monthly). When a report is 
run from a schedule, the report results can be sent to a list of e-mail recipients. 
 
Report Data is stored in an MS Access database by default, but can be migrated to an MS SQL 
database at any time. The MS Access report database is called REPORTDATA.MDBT and is located 
in the <INSTALL - DIR>\ Logs \  directory. 

 
The ActiveXperts Reports Module features the following: 
È Availability Reports. These reports contain reports aggregate fields, such as total up-time, 

total down-time etc. Aggregate fields are shown as absolute values (e.g. days, hours, 
minutes) as well as relative (percentage) values; 

È Detail Reports. These reports show all state changes, including reason for the state change 
and amount of time it remained in that particular state; 

È Filters - A comprehensive range of filters which can be applied to reports ensures that your 
reports only return the data you require. The filters available include checks, folders and 
results; 

È The Report Module offers different ways in which to specify the time period for which a report 
is to be run. A report can be run between specific dates and times or for a specific number of 
days, weeks, months or years from the current date or from the previous calendar period. 

È Create reports interactively (ad-hoc), from the command line or scheduled; 
È Dedicated tool (óReport Configuration Toolô) to define new report templates; 
È Supported formats: XML, XML/XSL, HTML and CSV; 
È Report distribution via e-mail. Scheduled Reports can be configured so that the report results 

are sent to a list of email recipients once the report has been run. Daily, Weekly and Monthly 
recurring schedules can be set up and reports attached to them to be run periodically with 
the results being distributed to a list of email recipients. In this way, ActiveXperts Network 
Monitor can be configured so that all reports are scheduled and ran automatically, with the 
report results being distributed automatically, so that no user input is required once the 
system has been set up. 

 

7.2. Report Definition Files (*.rep) 

To create a new report, you must always select a Report Definition file (.re p). This definition file 

describes the properties of a report, including: 
È Type of report, i.e. a ódetailô report or an óavailabilityô report. A ódetailô report shows the length 

of time the servers were in a particular state; an óavailabilityô report provides overall 
availability information of the servers; 

È Which checks (or groups of checks) should be included in the report; 
È Date ranges, like: today, this month, last 4 weeks, etc. 
È Output format. Supported output formats: XML, XML/XSL, HTML and CSV; 
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È Name of the output file. You can use placeholders to use dynamic report file names; 
È Filters; you can filter on Checks, Folders, Check Types, and Results; 
È E-mail recipients. 

 
ActiveXperts Network Monitor ships with a few pre-defined Report Definition file that can be used 
to create a new report, e.g.: 
È Availability_Day.rep  
È Availability_DayPrev.rep  
È Availability_Month.rep  
È Availability_MonthPrev.rep  
È Detail_Day.rep  
È Detail_DayPrev.rep  
È Detail_Month.rep  
È Detail_MonthPrev.rep  

7.3.  Creating a new Report manually 

Ƹ  Step 1: Launch the Report Generator Wizard 

You can launch the Report Generator tool from the Manager: open Reports from the Tools menu 
and select Create New Reporté. The Report Generator Wizard starts with a welcome screen. 
Click Next to continue. 

Ƹ  Step 2: Select a Report Definition File 

You must now select a Report Definition (.rep ) file. Such a definition file includes all properties of 

the new report, including type of report, date ranges, name of the report output file, etc.. 
You can use one of the pre-installed Report Definition files, but you can use your own Report 
Definition file. See also Chapter 7.4: ñCustomizing Reportsò. 

Ƹ  Step 3: Finish 

Finally, press Finish to create the report.  

The report is saved in the <INSTALL - DIR>\ Reports  directory, with a filename as specified in 

the Report Definition file. 
The results of the report creation are logged in the following file: <INS TALL-

DIR>\ LOGS\ REPORTGENERATOR.LOG 
 
You can choose not to send the report to the e-mail recipients (the check box is only enabled when 
the Report Definition file contains e-mail recipients).  

7.4.  Creating a new Report automatically (scheduled) 

The ActiveXperts Network Monitor Reports Module allows you to send out reports automatically to 
a specified list of e-mail recipients. This can be useful for scheduled reports, for instance for 
reports that run automatically every week or every month.  
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Ƹ  Step 1 ï Configure a Report Definition file with e-mail recipients 

To send a report to e-mail recipients from a scheduled job, you must configure the e-mail 

recipients in the Report Definition (.rep ) file. 

 
The ActiveXperts Report Modules uses the same global e-mail settings as the ActiveXperts 
Network Monitor Manager and the ActiveXperts Network Monitor Service, like: SMTP server, 
fallback SMTP server (if any), SMTP login credentials (if any), E-mail Address Book, etc. 
To change global e-mail settings, you must use the ActiveXperts Network Monitor Manager. 

 

To configure e-mail recipients for a Report Definition (.rep ) file:  

È Start the Report Configuration Tool;  
È Select a Report Definition File from the list, and press the Edit Selected button; 
È Select the E-mail Properties sheet; 
È Select the E-mail report checkbox. You can now edit the e-mail subject and e-mail body, 

and select the e-mail recipients. 
 

NOTE:  It is recommended to use E-mail Distribution Groups (from the E-mail Address Book) 
rather than individual recipients. With a Distribution Group, you donôt need to change 
the Report Definition file to add/remove a recipient. You just need to modify the 
Distribution Groupôs recipient list. Besides that, a Distribution Group can be used by 
multiple Report Definition files. 

 

Ƹ  Step 2 ï Create a test report from the command line (AxRgCmd.exe) 

Before you schedule a report using the Task Scheduler, it is recommended to test the report using 

the command line tool AxRgCmd.exe . This command line tool produces the same result as the 

graphical report tool (AxRgGui.exe ) described in Chapter 7.2, but does not require any user 

intervention so it can be run from the Task Scheduler. 
 
To create a new report from the command line: 
È Start a new Command Prompt. You can start the prompt by pointing to Run in the Start 

menu, and type: CMD.EXE 
You can also start a new prompt pointing to Accessories from the All Programs menu, and 
then select Command Prompt. 

È Change the current directory; set it to the network monitor installation directory. For instance: 
CD "C: \ Program Files \ ActiveXperts \ Network Monitor"   

È Start the command line program to create a new report. It requires one parameter: the 
Report Definition File to be used to create the new report. For instance: 
AXRGCMD.EXE /f  detai l_day .rep  

È The command line utility will create the report file. The output filename is specified in the 
Report Definition File. The results of the operations are logged in the following file: 
<INSTALL - DIR>\ LOGS\ REPORTGENERATOR.LOG 

Ƹ  Step 3 - Schedule a Report using the Task Scheduler 

Report creation can be automated by scheduling the creation of a report using the Windows Task 
Scheduler. Scheduling is often used to create monthly reports and send the report to a specified 
list of e-mail recipients. 
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With the Task Scheduler, you can only run the command-line version of the Report Creation Tool 
(AXRGCMD.EXE). The graphical version (AXRGGUI.EXE) requires user input and is not designed to 
run from the Task Scheduler. 
 
óStep 3ô already described how to use the AxRgCmd.exe tool command line tool. This tool can be 
used to create a report from the command line using a Report Definition (.rep) file, without user 
intervention, for example: 
 
For scheduled tasks, it is recommended to make use of a batch file to encapsulate parameters.  
For instance: C: \ Program Files \ ActiveXperts \ Network Monitor \  

Report Definitions \ BatchJobs \ Detail_Day .cmd : 

@echo off  
CD "C: \ Program Files \ ActiveXperts \ Network Monitor \ "  

AXRGCMD.EXE /f Detail_Day .rep  

 

To create a new scheduled report, perform the following steps: 
È Click Start, click Control Panel and double-click the Scheduled Tasks icon; 
È Double-click Add Scheduled Tasks. The Scheduled Task Wizard pops up; click Next to skip 

the welcome page; 
È Click the Browse button to select a batch job, for instance: 

C: \ Program Files \ ActiveXperts \ Network Monitor \  
Report Definitions \ BatchJobs \ Detail_Day .cmd  

È Specify a name for this task, and specify the frequency; 
È Specify credentials. It is recommended to use an account that is member of Local 

Administrator group; 
È Press Finish to complete the configuration of the scheduled task. 

7.5.  Customizing Reports 

ActiveXpertsô reporting is based on Report Definition Files (.rep ). Such a Report Definition file 

describes the characteristics of a new report, including: 
È Type of report, i.e. a ódetailô report or an óavailabilityô report; 
È Begin date and end date; 
È Filters; 
È Output format: XML, XML/XSL, HTML or CSV; 
È E-mail recipients; 

 
With the Report Configuration Tool, you can: 
È Create new Report Definition Files; 
È Modify existing Report Definition Files 
È Delete Report Definition Files 
 

To create/modify a Report Definition File: 
È Start the Report Configuration Tool by pointing to Reports from the Tools menu. Select 

Report Configuration Tool to launch the tool.  
È To create a new Report Definition File, click on the Add New button; 
È To modify an existing Report Definition File, select a Report Definition File from the list box 

and press the Edit Selected button. 
È When your create or edit a report, a wizard starts. It will prompt you for all necessary info. 
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Ƹ  Availability Reports vs. Detail Reports 

On of the configurable items in a Report Definition File is the type of report. It can be: 
È Availability Report; 
È Detail Report. 
 

An óavailabilityô report provides overall availability information of your servers/checks during the 
nominated date range. You can see uptimes and downtimes, in days, hours, minutes and seconds, 
and also as percentages. A óavailabilityô report is used for instance to compare real availability 
statistics against the SLA requirements. 
 
A ódetailô report provides a detailed list of all state changes during the nominated date range. For 
each check, you can see exactly when and why it failed, and for how long.  

Ƹ  Begin Date and End Date of a report 

On of the configurable items in a Report Definition File is the begin date and the end date selection 
of a report.  You can select the absolute begin date and end date, but it is recommended to use a 
relative begin date and end date. You can select the following relative date selectors: 
È This day; 
È This week; 
È This month; 
È This quarter; 
È Last x days; 
È Last x months; 
È Last x quarters; 
È Last x years. 

 

Ƹ  Output format 

One of the configurable items in a Report Definition File is the report output format. ActiveXperts 
Network Monitor supports four different output formats: 
È XML/XSL ï the output format is XML, and the screen layout definition is described in XSL. 

The XML file is generated automatically by the report generator, and contains a refrence to 
the XSL layout file; the XSL layout file is static and can be modified at any time. The 
XML/XSL pair can be read by any Internet browser; 

È XML ï this output formats is supported by many applications. This format is very useful when 
you want to import the report data into a 3rd party application. But since it has no reference to 
an XSL file, it has no graphical formatting. 

È HTML ï this format can be read by any browser; 
È CSV ï this output formats is supported by many applications. This format is very useful when 

you want to import the report data into a 3rd party application. 
 

Ƹ  Output filename 

On of the configurable items in a Report Definition File is the report output filename. 
You can choose for: 
È Static filename ï a fixed filename, without placeholders; 
È Dynamic filename ï a variable filename. It has year/month/day placeholder, so its name 

depends on the date when the report is created. 
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On of the configurable items in a Report Definition File is the report output filename. 
If you use scheduled day/week/month/quarter/year reports, it is recommended to use dynamic 
filenames. Otherwise, new report files will automatically overwrite olders ones, because the report 
output files have identical names. 
 
With dynamic files, the name of the report file depends on the date it is created. You can use the 
following placeholders: 
È DD ï day notation with leading zero 
È D ï day notation without leading zero 
È MM  ï month notation with leading zero  
È M ï month notation without leading zero 
È YYYY ï year notation 
È YYY ï year notation (3 digits only) 
È YY ï year notation (2 digits only) 
È Y ï year notation (1 digit only) 

 
Examples: 
 

    Filename:  Detail Report%MMDDYY%.xml 

    Date of creation: 20060422 

    Result:   Detail Report042206.xml  

 

    Filename:  Detail Report%MDYYYY%.xml  

    Date of creation: 20060422 

    Result:   Detail Report422 2006.xml  

Ƹ  Filters 

You can define filters in your Report Definition File to show only a subset of all checks in your 
reports. 
You can define the following filters: 
È Checks ï include all check in your report, or only a subset of all checks; 
È Check Types ï include all kinds of checks, or only a subset. You can for instance create a 

report that only contains ICMP and HTTP checks; 
È Result ï include only checks that have a specified result. For instance you can create a 

report of all checks with result: failed. 

Ƹ  E-mail 

The ActiveXperts Reports Module allows you to send out reports automatically to a nominated list 
of e-mail recipiuents. This is particularly useful for automated reports, where reports are created 
daily/weekly/monthly, automatically. Recipients are automatically notified of a new report. They just 
need to click on the URL that is inside the e-mail message. 
 
The ActiveXperts Reports Module makes use of the SMTP settings and E-mail address book of the 
ActiveXperts Network Monitor configuration. So, it uses the same primary- and secundary SMTP 
server as used by the ActiveXperts Network Monitor service. You can use the same e-mail 
distribution groups as used for e-mail alerts. 
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7.6.  Formatting Reports 

The HTML- and XML reports are based on an XSL stylesheet to format the report. 
With the HTML report, the stylesheet is used to create the HTML report. Once the report has been 
created, you cannot change the format of the produced HTML report. 
With XML based reports, a link to the XSL stylesheet is included in the XML report. This means 
that report data and formatting are stored in two separate file, so you can change the format of the 
XML report at any time. 

Ƹ  XML Report Data 

Appendix A: ñReport Data Formatò describes the Report Data of the XML files. 

Ƹ  XSL 

The ActiveXperts Reports Module allows you to send out reports automatically to a nominated list 
 
By default, all XML/HTML ódetailô reports are based on the following XSL stylesheet: 
 Detail Report.xsl  

All XML/HTML óavailabilityô reports are based on the following XSL stylesheet: 
 AvailabilityReport .xsl  

 
To change the format of a report, you can either modify the XSL file, or create a new custom XSL 
file and link the reports to the new XSL file. 
 
To create a new XSL file: 
È Start the Windows Explorer; 
È Point to the <IN STALLDIR> \ Report Definitions \ StyleSheets  directory; 
È Make a copy of an existing XSL sheet.  

 
To link a report to a new custom XSL file: 
È Start the Report Configuration Tool by pointing to Reports from the Tools menu. Select 

Report Configuration Tool to launch the tool; 
È Change the properties of a Report Definition (.rep) file; 
È In the Output Selection page, select a new XSL file. XSL files are located in the 

<INSTALLDIR> \ Report Definitions \ StyleSheets  directory. 
 
To modify an XSL file: 
È Start the Windows Explorer; 
È Point to the <INSTALLDIR> \ Report Definitions \ StyleSheets  directory; 
È Select an XSL file and choose Edit from the context menu.  

 
To change the format of an HTML or XML report requires basic knowledge of XSL. A good tutorial 
to XSL can be found here: Twww.w3schools.comT. 

Ƹ  Basic XSL statements 

Use the <xsl:for-each> tag to iterate over a set of checks. 
 

 <xsl:for - each se lect=" monitor/check " > 
    .. .  
    <br ><xsl:value - of select=" result " />< br > 

http://www.w3schools.com/


  Chapter 7.  Report Module 

   

      ActiveXperts Network Monitor      72 

</ xsl:for - each > 

 The XSL <xsl:for - each > element can be used to select every XML  element 

of a specified node set. The <xsl:value - of > element can be used to 
select the value of an XML element and add it to the output stream of 
the transformation.  

 
Use the <xsl:sort> tag to sort a record set. 
 

 <xsl:for - each select=" monitor/check " > 
<xs l:sort select=" result " />  
<xsl:sort select=" displayname " />  
    .. .  
<xsl:for - each > 

 To sort output it at the same time, simply add the  <xsl:sort > sort 
element inside the for - each element in your XSL file. Use multiple 
<xsl:sort > elements to sort on multiple  columns.  

 
 
Use the <xsl:if> tag to use a condition. 
 

 <xsl:if test=" result &gt; 2 " > 
  .. .  
</ xsl:if > 

 To put a conditional if test against the content of the file, simply 
add an <xsl:if > element to your XSL document. The value of the 
required test attrib ute contains the expression to be evaluated.  

 
 



  Chapter 8.  Permissions 

   

      ActiveXperts Network Monitor      73 

8.  Permissions 
 
You can assign the following permissions to users and groups of users: 
È No Access; 
È Read-only; 
È Read-write. 

 
ActiveXperts Network Monitor uses file system permissions to allow/disallow users to use the 
software. 
Only two files/shares are important when dealing with permissions: 
È The ActiveXperts Network Monitor share, which must be created to allow Remote Network 

Monitor Applications. Configure this Share through the Network Monitor Manager application 
on the machine where the Network Monitor Engine is running; 

È The TCONFIG.MDBT file ï this single file holds ALL the configuration data and is located in the 
T<installation directory> \ Configuration T directory on the ActiveXperts Network 
Monitor server; 

8.1.  No Access 

Use the ActiveXperts Network Monitor Share on the ActiveXperts Network Monitor server to assign 
No Access permissions to users or groups. 
 
By default, the following share permissions are assigned: 
 EveryOne:  Full Control  

This will allow all users on the network to install the ActiveXperts Network Monitor Manager 
application and to use the Manager application. 
 
Only assign share permissions to people who are allowed to use ActiveXperts Network 
Monitor. Always assign Change permissions on the share to people who will use ActiveXperts 
Network Monitor, even if they only need read-only permission. Change is required to allow read-
only users to send control information to the ActiveXperts Network Monitor service, for instance to 
request to monitor a particular server immediately. 
 
Two scenarios: 
UScenario 1U:  Allow only Domain Admins to use ActiveXperts Network Monitor. 
Share permissions: TDomain Admins:  Change T 

 
UScenario2U:   Allow everyone in the domain except users Joe 
Share permissions: TDomain Users:   Change T 

    Joe:     No Access  

8.2.  Read-only access 

Read-only access means, that a user can only view results of the ActiveXperts Network Monitor, 
but cannot make changes to the configuration. 
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The TCONFIG.MDBT file plays an important role in assigning read-only permissions. The 
TCONFIG.MDBT file holds ALL configuration data and is located in the T<INSTALL - DIR>\ CFG 

Tdirectory on the ActiveXperts Network Monitor server; 
 
People who are only allowed to view results of ActiveXperts Network Monitor, should have read-
only permissions on the TCONFIG.MDB Tfile. By having read-only access to the TCONFIG.MDBT file, 
the user cannot make changes to the configuration. 
The ActiveXperts Network Monitor Manager application detects the read-only permissions on the 
TCONFIG.MDB T and disables certain menuôs and commands for the particular user.  
Still assign Change permission on the Share for read-only users. Change permission is needed to 
send control information to the ActiveXperts Network Monitor service. 
 
UScenarioU:  Allow Domain Admins to configure ActiveXperts Network Monitor and view 

monitor results, allow all other people to view the monitor results only. 
Share permissions: TDomain Admins:  Change 

CONFIG.MDB: Domain Admins:  Change 

   Domain Users:   Read 

8.3.  Read/write access 

Read-write access means, that a user can view and configure ActiveXperts Network Monitor. 
People, who are allowed to make changes to the ActiveXperts Network Monitor configuration, 
should have Change permissions on the CONFIG.MDB file. By having Change access to the 
CONFIG.MDB file, the user can make changes to the configuration, as well as view the monitor 
results. 
 
UScenarioU:  Allow Domain Admins to configure ActiveXperts Network Monitor. 
Share permissions: Domain Admins:  Change 

CONFIG. MDB: Domain Admins:  Change 
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9.  Tuning the System 

9.1.  Introduction 

The ActiveXperts Network Monitor Engine (a Windows Service) is responsible for monitoring 
servers, workstations and devices from a central point. It is designed to run multiple checks 
simultaneously. To do so, it uses so called 'threads'. Multi-threading gives a program the ability to 
perform several tasks concurrently. 
 
In ActiveXperts Network Monitor, multiple threads are spawned, including: 
È Dispatcher - holds the configuration of the software. It has a queue of checks and decides 

which checks need to be checked. It determines which threads are busy and which threads 
are not, and passes a check to a thread that is capable of handling that type of check; 

È Notifications and Reports - Notifications can be time consuming, and are therefore assigned 
to threads to do its job. For instance, an SMS message through an SMSC dial-up provider 
can take up to 90 seconds. A NetPopup notification message to a non-existing NetBIOS 
recipient can take up to 10 seconds; 

È Checks - There are many threads for different checks, to optimize ActiveXperts Network 
Monitor's monitoring performance. There are threads for ICMP checks, Oracle checks, etc. 

 
The number of threads strongly influences the performance of the ActiveXperts Network Monitor 
Engine (service). If there are only a few threads, the software will not use much CPU and memory 
resources, but the throughput of checks may be low. By increasing the number of threads, the 
throughput will increase. However, too many threads will consume too many system resources 
together (each thread consumes memory and CPU), decreasing the performance of the Network 
Monitoring engine dramatically. 
 
It is recommended to have less than 40 threads on an average server. If - for instance - you have a 
lot of ICMP checks, and only a few VBScript based checks, you can increase performance by 
configuring a few more ICMP threads and a few less VBScript threads. 
 
On more powerful servers, you can configure more threads. 

9.2.  Configuring the number of Threads 

To configure the number of threads, choose Options from the Tools Menu and select the 
Advanced tab. Press on the top-most button. 
 
You find all different types of threads. You can change the number of threads that is spawned 
when the ActiveXperts Network Monitor is started. As a result, changes take affect after you restart 
the service! 
 
The following threads are used by the network Monitor Engine (service): 
È Environmental - Handles environmental related checks: 'Temperature', 'Humidity' and 

'Wetness'. Default number of Environental threads: 2. 
È ICMP/Ping - Handles 'ICMP/Ping' checks. Default number of threads: 4; 
È HTTP - Handles óHTTP/HTTPsô checks. Default number of threads: 4; 
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È FTP - Handles óFTPô and óTFTPô checks. Default number of threads: 1; 
È OLE DB - Handles generic óDatabaseô checks, including checks for MS Access and MS SQL. 

Default number of threads: 2; 
È Oracle - Handles óOracleô checks. Default number of threads: 1. 

IMPORTANT: you can configure only 1 Oracle thread; 
È Serial Communications - Handles óSerial Deviceô checks. Default number of threads: 1; 
È SSH - Handles óSSHô checks. Default number of threads: 1; 
È SMTP to POP3 - Handles óSMTP to POP3ô checks. Default number of threads: 1; 
È SNMP Trap Receiver - Handles óSNMP Trap Receiveô checks. Default number of threads: 1; 
È Socket - Responsible for Winsock related checks: 'TCP', 'POP3', 'SMTP', 'RSH', 'SNMP', 

'NTP', 'NNTP', 'Terminal Server', 'IMAP' and 'DNS'. Default number of Socket threads: 4; 
È VBScript - Responsible for handling VBScript based checks, including custom VBScript 

checks. Default number of VBScript threads: 4. 
IMPORTANT: you cannot define more than 8 VBScript threads; 

È Win32 - Responsible for handling the following checks: 'Directory Size', 'Disk Space', 
'Service' and 'File Existence'. Default number of Win32 threads: 4; 

È WMI - Responsible for handling all WMI based checks: 'CPU', 'Disk Drives', 'Memory', 
'Printer', 'Process' and 'Event Log'. Default number of WMI threads: 4. 

 

9.3.  Log files 

ActiveXperts Network Monitor maintains its own log files. By default, logging is enabled, and is 
written to the T<INSTALL- DIR>\ LOGST directory. You can change this directory from the Options 
dialog in the Tools menu. 
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10.  Troubleshooting 
 
Visit our website at Thttp://www.activexperts.com/support/activmonitor T for a complete FAQ list. 
You can also send an email to our support staff: Tsupport@activexperts.comT. 
 

http://www.activxperts.com/support/activmonitor
mailto:support@activexperts.com
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11.  Purchase and Product Activation 

11.1.  License Scheme 

 
ActiveXperts Network Monitor licensing options: 
Á Small Business License. 

This license allows you to install and use the software on any workstation or server in your 
organization.  
You are allowed to monitor up to 10 IP-devices/workstations/servers inside your organization. 
You are not allowed to monitor any device/workstation/server outside your organization, except 
servers that are on the public internet (for instance: web servers, mail servers, etc.).  
You are not allowed to install the software outside your organization or distribute the product as 
part of your own software. 

Á Enterprise license. 
This license allows you to install and use the software on any workstation or server in your 
organization.  
You are allowed to monitor an unlimited number of IP-devices/workstations/servers inside your 
organization.  
You are not allowed to monitor any IP-device/workstation/server in other organizations, except 
servers that are on the public internet (for instance: web servers, mail servers, etc.).  
You are not allowed to install the software outside your organization or distribute the product as 
part of your own software. 

Á Universal License - 5 Organizations. 
This license allows you to install and use the software on any workstation or server in your 
organization.  
You are allowed to monitor an unlimited number of IP-devices/workstations/servers inside your 
organization.  
You are also allowed to monitor an unlimited number of IP-devices/workstations/servers in 5 
other organizations.  
You are not allowed to distribute the software as part of your own software. 

Á Universal License - Unlimited Organizations. 
This license allows you to install and use the software on any workstation or server in your 
organization.  
You are allowed to monitor an unlimited number of IP-devices/workstations/servers inside your 
organization.  
You are also allowed to monitor an unlimited number of IP-devices/workstations/servers in any 
other organization (unlimited).  
You are not allowed to distribute the software as part of your own software. 

 
Please visit: 
    Thttp://www.activexperts.com/salesT 
to read more about our licensing schemes. 

11.2.  Purchase 

Please visit: 

http://www.activexperts.com/sales
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    Thttp://www.activexperts.com/salesT 
to read more about how to purchase the product. On this site, you can also find the URL to make 
an online order. 

 
You can also contact us via email: Tsales@activexperts.comT. 

11.3.  Product Activation  

After you have installed the product, you can use the software for 30 days. All features are 
available during this period. After 30 days, the Manager application can still be launched, and the 
service will keep on running. However, you wonôt be able to (re)start the service anymore. 
 
During the trial period, you can check how many days are left at any time: go to the Help menu 
and select the About ActiveXperts Network Monitor menu item. Itôll pop up an about dialog, 
which displays the number of days remaining. 
 
After you purchase the product, you will receive one or more product registration keys. These must 
be entered by using the ActiveXperts Network Monitor Manager application. 
 
To enter the registration code, go to the Help menu, and choose Registration. Enter the 
registration code and press OK. 

http://www.activexperts.com/sales
mailto:sales@activexperts.com
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APPENDIX A: Report Data Format 

A.1.  XML Availability Reports 

To customize óavailabilityô reports, you need to make changes to the XSL file.  
Before you can make changes to the XSL file, a little understanding of the XML document is 
required. 
 

The XML document is the result of the Report Creation Tool (either AXRGGUI.EXE or 

AXRGCMD.EXE). It has a reference to a static XSL document. This XSL document describes how 

the XML document should be displayed. 
 
The XML document of a óavailabilityô report looks like this: 
 <?xml version="1.0" encoding="UTF - 8"?>  

 <?xml - stylesheet type="tex t/xsl" href="stylesheets \ Availability Report.xsl"?>  
 <monitor > 
  <from - secs >1154124000 </ from - secs > 
  <to - secs >1154210399 </ to - secs > 
  <from - date >07/29/2006 12:00:00 AM </ from - date > 
  <to - date >07/29/2006 11:59:59 PM </ to - date > 
  <check > 
    <id >10288 </ id > 
    <displayname >www.monitortools. com -  ICMP Ping </ displayname > 
    <check >ICMP</ check > 
    <folder >\ </ folder > 
    <uncertain - secs >0</ uncertain - secs > 
    <uncertain - hrsmin >000 00:00:00 </ uncertain - hrsmin > 
    <uncertain - pct >0.00% </ uncertain - pct > 

    <success - secs >1829 </ success - secs > 
    <success - hrsmin >000 00:30:29 </ success - hrsmin > 
    <success - pct >2.12% </ su ccess - pct > 
    <failure - secs >0</ failure - secs > 
    <failure - hrsmin >000 00:00:00 </ failure - hrsmin > 
    <failure - pct >0.00% </ failure - pct > 
    <maintenance - secs >0</ maintenance - secs > 
    <maintenance - hrsmin >000 00:00:00 </ maintenance - hrsmin > 
    <maintenance - pct >0.00%</ maintenance - pct > 
    <onhold - secs >0</ onhold - secs > 
    <onhold - hrsmin >000 00:00:00 </ onhold - hrsmin > 
    <onhold - pct >0.00% </ onhold - pct > 
    <depfailure - secs >0</ depfailure - secs > 
    <depfailure - hrsmin >000 00:00:00 </ depfailure - hrsmin > 
    <depfailure - pct >0.00% </ depfailure - pct > 
    <notprocessed - secs >84570 </ notprocessed - secs > 
    <notprocessed - hrsmin >000 23:29:30 </ notprocessed - hrsmin > 
    <notprocessed - pct >97.88% </ notprocessed - pct > 

  </ check > 
  <check > 
    ...  
  </ check > 
 </ monitor > 

 

 
Description of the Tags used in the above XML report documentT: 
 

 Tag  Description 
 <from - secs > Begin time of report, in seconds after 01/01/1970  

 <from - date > Begin time of report, in date format (i.e. 
mm/dd/yyyy)  

 <to - secs > End time of report, in seconds after 01/01/1970  

 <to - date > End time of report, in date format (i.e. 
mm/dd/yyyy)  
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 <check/id > ID of the Check, as it is used throughout the 
whole program  

 <check/displayname > DisplayName of the Check, as it is used throughout 
the whole program  

 <check/success - secs > Total amount of time (in seconds) that Check had 
status: Success  

 <check/success - hrsmin > Total amount of time (in hh:mm format) that Check 
had status: Success  

 <check/success - pct > Total amount of time (in percentage of total 
Report time) that Check had status:  Success  

 <check/failure - secs > Total amount of time (in seconds) that Check had 
status: Failure  

 <check/failure - hrsmin > Total amount of time (in hh:mm format) that Check 
had status: Failure  

 <check/failure - pct > Total amount of time (in percentage of tot al 
Report time) that Check had status: Failure  

 <check/uncertain - secs > Total amount of time (in seconds) that Check had 
status: Uncertain  

 <check/uncertain - hrsmin > Total amount of time (in hh:mm format) that Check 
had status: Uncertain  

 <check/uncertain - pct > Total amount of time (in percentage of total 
Report time) that Check had status: Uncertain  

 <check/depfailure - secs > Total amount of time (in seconds) that Check had 
status: Dependee Failure  

 <check/depfailure - hrsmin > Total amount of time (in hh:mm format) that Check 
had status: Dependee Failure  

 <check/depfailure - pct > Total amount of time (in percentage of total 
Report time) that Check had status: Dependee 
Failure  

 <check/maintenance - secs > Total amount of time (in seconds) that Check had 
status: M aintenance  

 <check/maintenance - hrsmin > Total amount of time (in hh:mm format) that Check 
had status: Maintenance  

 <check/maintenance - pct > Total amount of time (in percentage of total 
Report time) that Check had status: Maintenance  

 <check/onhold - secs > Total amount of time (in seconds) that Check had 
status: On Hold  

 <check/onhold - hrsmin > Total amount of time (in hh:mm format) that Check 
had status: On Hold  

 <check/onhold - pct > Total amount of time (in percentage of total 
Report time) that Check had stat us: On Hold  

 <check/notprocessed - secs > Total amount of time (in seconds) that Check had 
status: Not Processed  

 <check/notprocessed - hrsmin > Total amount of time (in hh:mm format) that Check 
had status: Not Processed  

 <check/notprocessed - pct > Total amount  of time (in percentage of total 
Report time) that Check had status: Not Processed  

A.2.  XML Detail Reports 

To customize ódetailô reports, you need to make changes to the XSL file.  
Before you can make changes to the XSL file, a little understanding of the XML document is 
required. 
 

The XML document is the result of the Report Creation Tool (either AXRGGUI.EXE or 

AXRGCMD.EXE). It has a reference to a static XSL document. This XSL document describes how 

the XML document should be displayed. 
 
The XML document of a ódetailô report looks like this: 

 <?xml version="1.0" encoding="UTF - 8"?>  

 <?xml - stylesheet type="text /xsl" href="stylesheets \ Detail Report.xsl"?>  
 <monitor > 
  <from - secs >1154124000 </ from - secs > 
  <to - secs >1154210399 </ to - secs > 
  <from - date >07/29/2006 1 2:00:00 AM </ from - date > 
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  <to - date >07/29/2006 11:59:59 PM </ to - date > 

  <check > 

    <id >10288 </ id > 
    <displayname >www.monitortools.com -  ICMP Ping </ displayname > 
    <checktype >ICMP</ checktype > 
    <checktype - id >10</ checktype - id > 
    <folder >\ </ folder > 
    <event > 
      <from - secs >1154124000 </ from - secs > 
      <from - date >07/29/2006 </ from - date > 
      <from - time >12:00:00 AM </ from - time > 
      <to - secs >1154202296 </ to - secs > 
      <to - date >07/29/2006 </ to - date > 
      <to - time >09:44:56 PM </ to - time > 
      <result - id >0</ result - id > 
      <result >Not monitored </ result > 
      <duration - secs >78296 </ duration - secs > 
      <duration >000 21:44:56 </ duration > 
      <reason >Not monitored </ reason > 
    </ event > 

    <event > 
      ...  
    </ event > 
  </ check > 
  <check > 
    <id >10289 </ id > 
    <displayname >flkjfskdlf -  ICMP Ping </ displayname > 
    ...  
    <event > 
      ...  
    </ event >     
    <event > 
      ...  
    </ event > 
    ...  
  </ check > 
 </ monitor > 

 

 
Description of the Tags used in the above XML document T: 
 

 Tag  Description  

 <from - se cs > Begin time of report, in seconds after 01/01/1970  

 <from - date > Begin time of report, in date format (i.e. 
mm/dd/yyyy)  

 <to - secs > End time of report, in seconds after 01/01/1970  

 <to - date > End time of report, in date format (i.e. 
mm/dd/yyyy)  

 <check /id > ID of the Check, as it is used throughout the 
whole program  

 <check/displayname > DisplayName of the Check, as it is used throughout 
the whole program  

 <check/event/from - secs > Begin time of the event, in seconds after 

01/01/1970  

 <check/event/from - date > Begin time of the event, in date format (i.e. 
mm/dd/yyyy)  

 <check/event/from - time > Begin time of the event, in time format (i.e. 
hh:mm:ss)  

 <check/event/to - secs > End time of the event, in seconds after 01/01/1970  

 <check/event/to - date > End time of the event, in date format (i.e. 
mm/dd/yyyy)  

 <check/event/to - time > End time of the event, in time format (i.e. 
hh:mm:ss)  

 <check/event/result > The last Result of the Check, represented by a 
string  

 <check/event/result - id > The last Result of the Check, d escribed by a 
unique number. The Result IDôs are described later 
in this chapter  

 <check/event/duration - secs > Duration of the event, in seconds  
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 <check/event/duration > Duration of the event, formatted as: óxx hrs yy 
minô 

A.3. Contants 

Ƹ  Check Type ID 

The <checktype-id> tag can hold any of the following pre-defined values: 
 

 Check Type ID  Description  

 0 <UNDEFINED TYPE> 

 1 <FOLDER> 

 10 ICMP 

 20 Disk Space  

 30 TCP/IP  

 31 POP3 

 32 SMTP 

 33 HTTP(s)  

 34 FTP 

 35 RSH 

 36 DNS 

 37 SNMP 

 38 NNTP 

 39 IMAP 

 40 NTP 

 41 Temperature  

 42 SNMP Trap Receive  

 43 SSH 

 50 Service  

 60 File  

 70 Anti - Virus / Anti - Spam 

 71 MS Active Directory  

 72 MS Hyper - V Server  

 73 MS Exchange  

 74 MS IIS Server  

 75 MS ISA Server  

 76 MS SharePoint S erver  

 77 MS SQL Server  

 90 Event Log  

 100  VBScript  

 110  ODBC 

 111  Database (OLE DB)  

 112  Oracle  

 120  MS Terminal Server  

 130  CPU 

 140  Directory Size  

 150  Disk  

 160  Floppy  

 170  Memory 
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 180  Printer  

 190  Process  

 200  Humidity  

 201  Power  

 202  Light  

 203  Motion  

 204  Smoke 

 205  Door  

 206  Resistance  

 207  Switch (NC)  

 208  Switch (NO)  

 210  Wetness  

 220  Shceduled Task  

 240  SMTP to POP3  

 250  MSMQ 

 260  Serial Device  

 270  TFTP 

 280  Remote Command 

 290  PowerShell  

 300  Radius  

 310  SFTP 

Ƹ  Result ID 

The<result-id> tag can hold any of the following pre-defined values: 
 

 Result ID  Description  

 0 Uncertain  

 1 Success  

 2 Error  

 3 Failure  

 4 Maintenance  

 5 On Hold  

 6 Dependee Error  

 7 Dependee Failure  

 99 Not Processed  
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APPENDIX B: Web Interface XML Tags 
 
 
To customize óavailabilityô reports, you need to make changes to the XSL file.  
Before you can make changes to the XSL file, a little understanding of the XML document is 
required. 
 
XML data is represented as a series of XML Tags. Each set of Tags (record) can be used as an 
interface to a database. For instance, you can import the XML data in a MS SQL database 
regularly. 
 
As mentioned before, XML allows customs tags and a custom document structure; ActiveXperts 
Network Monitor defines its own tags for its Web Views. 
Each Monitoring Check is enclosed by T<check >T and T</check >T tags, and describes the last 
result of the check as processed by the Network Monitor Engine. The following tags are used to 
describe the result of the check:  
 

 Tag  Description  

 <id > Unique ID of the Check; The ID is a long 
integer, and is also the key in the 
database ( CONFIG.MDB) for the check  

 <displayname > DisplayName of the Check, as it is used 
throughout the whole program  

 <folder > Full Folder Path where Check is located  

 <typ e- id > Type of Check, also called óCheckô. 
Every Check has a Unique ID (for 
instance: ICMP=10, DiskSpace=20, 

Service=50, etc.). Type IDôs are 
described later in this chapter  

 <type > Type of Check  

 <result - id > The last Result of the Check, described 
by a u nique number. The Result IDôs are 
described later in this chapter  

 <result > The Last Result of the Check, shown as a 
string  

 <data > The actual data (if exists) of the 
monitored item.  

 <bitmap > Bitmap indicating the result of the 
processed Check  

 <expl anation > Basic explanation of the result  

 <comments > Additional comments to the result  

 <update - secs > Last Update time, in seconds after 
01/01/1970  

 <update > Last Update time, shown as a friendly 
string  
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APPENDIX C: Notification Variables 
 
 
Notification Variables are variables which are substituted by the Network Monitor Engine when an 
action is triggered or a notification is sent.  
There are several places in the Network Monitor software where you can use System Variables.  
You can use system variables inside Message Templates, on the command prompt when running 
an executable or VBScript program, and in SNMP Trap notifications. 
 
Notification Variables must be enclosed between T<%T and T%>T tags, for example: T<% DATE %>. T 
The following variables can be used: 
È T<%DATE%>T    ï The Date of the event; 
È T<%TIME%>T    ï The Time of the event; 
È T<%ID %>  T  ï The unique ID of the Monitoring Check; 
È T<%DISPLAYNAME%>T  ï Name of the Monitoring Check; 
È T<%TYPE- ID %>T   ï Type of check. Each check has a unique ID; 
È T<%TYPE%>T    ï Type of check (friendly string); 
È T<%SERVER%>T   ï Name of the server/device that is being checked; 
È T<%RESULT- ID %>T  ï The Result ID of the event. Each Result has a unique ID; 
È T<%RESULT%> T  ï The Result of the event (friendly string); 
È T<%DATA%>T    ï Actual data item; 
È T<%EXPLANATION%>T  ï Detailed description of the result of the event. 

Ƹ  DATE variable 

The date the event occurred. 

Ƹ  TIME variable 

The time the event occurred. 

Ƹ  ID variable 

The unique ID of the Monitoring Check. Each check has a unique ID.  

Ƹ  DISPLAYNAME variable 

The description of the Monitoring Check. Operators can change the display name by changing 
the Display Name field in the General Settings of the properties of that check. 

Ƹ  TYPE-ID variable 

Type of check. Each check has a unique ID. Appendix A.3. contains an overview of all Check Type 
IDôs and the corresponding descriptions.  

Ƹ  TYPE variable 

Type of check (friendly string).  
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Ƹ  SERVER variable 

The server/device that was checked. In most cases, the SERVER name will be a hostname, 
NetBIOS name or an IP number. It depends on the kind of check that is being performed.  

Ƹ  RESULT-ID variable 

The Result ID of the Event. Each Result has a unique ID. Appendix A.3. contains an overview of all 
Result IDôs. 

Ƹ  RESULT variable 

The Result of the Event (friendly string).  

Ƹ  DATA variable 

Actual data item (if available). The variable holds the value that is retrieved. For instance, when 
monitoring CPU usage, the óDataô variable holds the actual CPU usage, for instance: 60. 

Ƹ  EXPLANATION variable 

Additional information about the result of the last check. 
 
 
 


